Adobe

**After Effects CS6**

Visual Effects and Compositing

**STUDIO TECHNIQUES**

Mark Christiansen
## Contents

Foreword to This Edition xi  
Foreword xiii  
Introduction xxi  

### Section I  Working Foundations

**Chapter 1 Composite in After Effects**  1  
A Basic Composite  2  
Compositing Is A Over B… and a Bit More  8  
Get Settings Right  15  
Using the User Interface Like a Pro  22  
"Effects" in After Effects:  
Plug-ins and Animation Presets  29  
Output: Render Queue and Alternatives  30  
Assemble Any Shot Logically  33  

**Chapter 2 The Timeline**  35  
Dreaming of a Clutter-Free Workflow  36  
Timing: Keyframes and the Graph Editor  42  
Shortcuts Are a Professional Necessity  52  
Animation: It's All About Relationships  55  
Accurate Motion Blur  58  
Timing and Retiming  62  
What a Bouncing Ball Can Teach You About Yourself  69  

**Chapter 3 Selections: The Key to Compositing**  71  
Beyond A Over B: How to Combine Layers  72  
Edges on Camera (and in the Real World)  78  
Transparency and How to Work With It  81  
Mask Options and Variable Mask Feather  84  
Mask Modes and Combinations  88  
Animated Masks  90  
Composite With or Without Selections:  
  Blending Modes  92  
  Share a Selection with Track Mattes  98  
  Right Tool for the Job  100  

**Chapter 4 Optimize Projects**  101  
Work With Multiple Comps and Projects  102  
Special Case: Adjustment and Guide Layers  110  
Image Pipeline, Global Performance  
  Cache, and Render Speed  113  
Optimize a Project  126  
These Are the Fundamentals  129
## Section II  Effects Compositing Essentials

### Chapter 5  Color Correction  131
- Color Correction and Image Optimization  133
- Levels: Histograms and Channels  140
- Curves: Gamma and Contrast  143
- Hue/Saturation: Color and Intensity  149
- Compositors Match Colors  150
- Beyond the Ordinary, Even Beyond After Effects  165

### Chapter 6  Color Keying  167
- Procedural Mattes for the Lazy (and Diligent)  168
- Linear Keyers and Hi-Con Mattes  170
- Color Keying: Greenscreen, Bluescreen, and (Very Rarely) Redscreen  174
- Keylight: The After Effects Keying Tool  184
- Fine-Tuning and Problem Solving  189
- Fix It on Set  197
- More Alternatives for an Impossible Key  201

### Chapter 7  Rotoscoping and Paint  203
- Roto Brush for the Diligent (or Lazy)  205
- Articulated Mattes  211
- Refined Mattes: Feathered, Tracked  215
- Paint and Cloning  218
- Avoid Roto and Paint  224

### Chapter 8  Effective Motion Tracking  225
- Track a Scene with the 3D Camera Tracker  227
- Warp Stabilizer: Smooth Move  233
- The Point Tracker: Still Useful  245
- Mocha AE Planar Tracker: Also Still Quite Useful  252
- Camera Integration  259

### Chapter 9  The Camera and Optics  263
- Know Your Camera: Virtual and Real  264
- 3D Layers Are Born  274
- Stereoscopic 3D Integration  278
- The Camera Tells the Story  285
- Focal Depth and Bokeh Blur  292
- Don’t Forget Grain  303
- Real Cameras Distort Reality  308
- Train Your Eye  316

### Chapter 10  Expressions  317
- What Expressions Are  318
- Creating Expressions  319
- The Language of Expressions  321
About the Author

Mark Christiansen is a San Francisco–based visual effects supervisor and creative director. Some of his Hollywood feature and independent film credits include Avatar, All About Evil, The Day After Tomorrow and Pirates of the Caribbean 3: At World’s End. As a director, producer, designer, and compositor/animator, he has worked on a diverse slate of commercial, music video, live event, and television documentary projects for a diverse set of Hollywood and Silicon Valley clients. More recently he has been employed directly by Adobe to produce video marketing material. It was a brief stint advising on the set of Beasts of the Southern Wild that sparked the concept for Cinefex for iPad and foundation of the company that produced it—New Scribbler.

Mark has used After Effects since version 2.0 and has worked directly with the After Effects development and marketing teams over the years. He has written four previous editions of this book, and has contributed to other published efforts, including the Adobe After Effects Classroom in a Book and After Effects 5.5 Magic (with Nathan Moody).

Mark is a founder of Pro Video Coalition (provideocoalition.com). He has created video training for Digieffects, lynda.com, and fxphd.com, and has taught courses based on this book at Academy of Art University. You can hear him on popular podcasts such as “The VFX Show” and you can find him at christiansen.com.
About the Contributors

**Jeff Almasol** (Appendix: Scripting) is a senior quality engineer on the Adobe After Effects team by day and crafter of After Effects scripts at his redefinery.com site by night. His site provides numerous free scripts, reference material, and links to other scripting resources. Prior to Adobe, Jeff worked at Elastic Reality Inc. and Avid Technology on Elastic Reality, Marquee, AvidProNet, and other products; and at Profound Effects on Useful Things and Useful Assistants. You might find him talking in the third person on Twitter (redefinery) and other sites.

**Dan Ebberts** (Chapter 10: Expressions and After Effects Javascript Guide) is a freelance After Effects script author and animation consultant. His scripting services have been commissioned for a wide range of projects, including workflow automation and complex animation rigging. He is a frequent contributor to the various After Effects forums and has a special interest in expressions and complex algorithms. Dan is an electrical engineer by training, with a BSEE degree from the University of California, but has spent most of his career writing software. He can be reached via http://motionscript.com.

**Stu Maschwitz** (Foreword) is a writer and director, and the creator of the Magic Bullet Suite from Red Giant Software. Maschwitz spent four years as a visual effects artist at George Lucas’s Industrial Light & Magic (ILM), working on such films as *Twister* and *Men in Black*. He cofounded and was CTO of The Orphanage, a San Francisco-based visual effects and film production company. Maschwitz has directed numerous commercials and supervised effects work on films including *Sin City* and *The Spirit*. Maschwitz is a guerilla filmmaker at heart and combined this spirit and his effects knowledge into a book: *The DV Rebel’s Guide: An All-Digital Approach to Making Killer Action Movies on the Cheap* (Peachpit Press).
To the true spirit of collaboration.

Acknowledgments

This book wouldn’t exist without the dedication of the After Effects team at Adobe to make the best software they can for more than two decades, which is nearly how long I’ve been working with it. I started with the CoSA After Effects 2.0 beta at LucasArts—back before I knew the term “compositor”—and was soon blowing minds with what I could do on a beige Mac.

In this edition, I also thank Adobe specifically in a couple of ways. There couldn’t be a better technical editor than Todd Kopriva, who made time in his more-than-full schedule to review this book. And during the development of this book, I have had an office at Adobe, where I’ve had the opportunity take part in the tremendous step forward for video that is CS6. Thanks to Paramita Bhattacharya and Ellen Wixted for making me more of an insider than ever.

And, of course, I remain grateful to filmmaker Stu Maschwitz, who cofounded and was CTO of The (late, great) Orphanage, without whom the first edition of the book wouldn’t have been what it was. Working with Stu directly on A-list feature films gave me the confidence that the techniques in this book were valid and worth sharing.

Maintaining that standard has been possible only with the collaboration of others. Thanks to Dan Ebberts for his work on Chapter 10, “Expressions,” and his counterpart on the scripting side, Jeff Almasol. Jeff even contributed several useful scripts that he and I cooked up specifically for readers of this book. Thanks also to Sébastien Perier for revamping a few of the expressions examples for this edition.

I’m proud of the way this edition looks, and that’s thanks in no small part to Jim Geduldick and Tyler Ginter, each of whom contributed high-speed action footage from the Phantom camera. If you haven’t seen Tyler’s project “Holi,” find it on Vimeo—it’s amazing. We also have
footage, courtesy of Adobe, which was shot by Vincent LaForet. The LaForet footage is used for motion tracking and color look examples throughout the book; it’s a treat to work with footage that is properly shot, well lit, and completely flat, ready to be manipulated. Bob Donlon of Wrecking Ball and Adam Shaening-Pokrasso of 12fps contributed the nightclub shots featuring the Afrolicious band. Thanks guys!

I learn from teaching and thank past students and collaborators at Academy of Art and fxphd.com for reminding me of the need for clear, patient, lucid descriptions of fundamentals.

Repeat thanks to Tyler McPherron, Chris Meyer, Eric Escobar, and Brendan Bolles for contributions retained from previous editions. In addition, I thank Mike Chance and Jesse Boots (of Project Arbiter), Pixel Corps, Artbeats, fxphd, Case Films, Creative COW, Kenwood Group, Inhance, Sony, ABC, Red Bull USA, and individuals such as Pete O’Connell, Benjamin Morgan, Matt Ward, Ross Webb, Luis Bustamente, Micah Parker, Fred Lewis, Jorge L. Peschiera, Shuets Udono, Eric E. Yang, Charlie Styr, Mike Sussman, Marco Abis, Håkan Dahlström, and Kevin Miller. Thanks to Flickr for the Creative Commons tag that allows incorporation of fantastic images from willing contributors around the world.

Alicia Buelow designed this book’s cover with guidance from Charlene Charles-Will. Thanks to Peachpit for commissioning original artwork for the cover, and to the team for patiently working through a number of revisions. It was worth the trouble.

The people on the After Effects team at Adobe have made this application what it is. Dave Simons and Dan Wilk go all the way back, and Chris Prosser and Steve Forde now ably guide it forward (and offer smart, clear, concise responses to technical questions). One of the biggest thrills during this cycle was to travel to Seattle and have nearly the entire team come out for Thai food—we took over the restaurant.
This book relies on the commitment of Peachpit Press to manage the highest-quality publications possible in a world of increasing costs and continual shifts in the marketplace. My editor for three print editions now, Karyn Johnson, devoted long hours and extraordinary energy to everything from minuscule copyedits to coordination of the many pieces that need to come together to make a book. Karyn, the readers of this book get the benefit of your professionalism and genuine commitment to quality, while I have been the beneficiary of your sense of humor, fun—and patience! I hope some higher-ups at Pearson are listening—they are lucky to have you.

Finally, thank you to you, the people who read, teach, and bring the material in this book to life to collaborate on your own stories. Please let me know what you think at aestudiotechniques@gmail.com.
Foreword to This Edition

Face it, Bart, Sideshow Bob has changed.
No, he hasn’t. He’s more the same than ever!
—Lisa and Bart Simpson in “Brother from Another Series,” The Simpsons, Season 8

The first edition of this book was published in 2005, and I wrote the foreword for the third edition in 2008. I just read it, with an eye to updating it. I didn’t change a word.

Everything I wrote then is even more true today. I’m seeing it every time I turn on my television—people are losing their preoccupation with realism and just telling stories. Certainly in many cases this is due to drastically reduced budgets. Nothing inspires creativity like limited resources. But if you can make your point as effectively with a stylized—but-beautiful animation, suddenly spending months of work to “do it photo-real” seems like more than just squandered resources; it seems to miss the point altogether.

Today, our phones come with 1080p video cameras, and our favorite visual effects application comes bundled with a 3D tracker. Every week on Kickstarter there’s a new project designed to make some aspect of film production even more accessible. We’re expected to make even more for even less.

The combination of Adobe After Effects CS6 and this book remains your best asset in that battle. What I wrote in 2008’s foreword was controversial and challenging at the time, but today it just feels like common sense. When the season finale of a hit TV show is shot using a camera that you can buy at the corner camera store—when a professional cinematographer is willing to suffer through compression artifacts and other technical shortcomings of that camera because the images he makes with it create an emotional experience he can’t achieve any other way—you’re in the middle of a sea change. It’s not the 100-artist facilities or the shops with investments in “big iron” that are going to come out on top. The victory will go to the
artists who generate an emotional reaction by any means necessary. The filmmaker with an entire studio in her backpack. The visual effects artist who has an entire show’s worth of shots slap-comped while the editor is still loading footage. The graphic designer who ignores the stale collection of stock footage and shoots his own cloud time-lapse using a $.99 iPhone app.

Four years ago it was fun to think about bringing the sex to your work. Today it’s necessary for survival. Use what you learn in this book to make beautiful things that challenge and excite people. The tools have gotten better. It’s up to you to translate that into a better audience experience.

—Stu Maschwitz
Foreword

I can’t see the point in the theatre. All that sex and violence. I get enough of that at home Apart from the sex, of course.

—Tony Robinson as Baldrick, Blackadder

Who Brings the Sex?

“Make it look real.” That would seem to be the mandate of the visual effects artist. Spielberg called and he wants the world to believe, if only for 90 minutes, that dinosaurs are alive and breathing on an island off the coast of South America. Your job: Make them look real. Right?

Wrong.

I am about to tell you, the visual effects artist, the most important thing you’ll ever learn in this business: Making those velociraptors (or vampires or alien robots or bursting dams) “look real” is absolutely not what you should be concerned with when creating a visual effects shot.

Movies are not reality. The reason we love them is that they present us with a heightened, idealized version of reality. Familiar ideas—say, a couple having an argument—but turned up to 11: The argument takes place on the observation deck of the Empire State building, both he and she are perfectly backlit by the sun (even though they’re facing each other), which is at the exact same just-about-to-set golden-hour position for the entire 10-minute conversation. The couple are really, really charming and impossibly good-looking—in fact, one of them is Meg Ryan. Before the surgery. Oh, and music is playing.

What’s real about that? Nothing at all—and we love it.

Do you think director Alejandro Amenábar took Javier Aguirresarobe, cinematographer on The Others, aside and said, “Whatever you do, be sure to make Nicole Kidman look real?” Heck no. Directors say this kind of stuff to their DPs: “Make her look like a statue.” “Make him look bullet-proof.” “Make her look like she’s sculpted out of ice.”
Did It Feel Just Like It Should?

Let’s roll back to *Jurassic Park*. Remember how terrific the T-rex looked when she stepped out of the paddock? Man, she looked good.

She looked good.

The realism of that moment certainly did come in part from the hard work of Industrial Light and Magic’s fledgling computer graphics department, which developed groundbreaking technologies to bring that T-rex to life. But mostly, that T-rex felt real because she looked good. She was wet. It was dark. She had a big old Dean Cundey blue rim light on her coming from nowhere. In truth, you could barely see her.

But you sure could hear her. Do you think a T-rex approaching on muddy earth would really sound like the first notes of a new THX trailer? Do you think Spielberg ever sat with sound designer Gary Rydstrom and said, “Let’s go out of our way to make sure the footstep sounds are authentic?” No, he said, “Make that mofo sound like the Titanic just rear-ended the Hollywood Bowl” (may or may not be a direct quote).

It’s the sound designer’s job to create a soundscape for a movie that’s emotionally true. They make things feel right even if they skip over the facts in the process. Move a gun half an inch and it sounds like a shotgun being cocked. Get hung up on? Instant dial tone. Modern computer displaying something on the screen? Of course there should be the sound of an IBM dot-matrix printer from 1978.

Sound designers don’t bring facts. They bring the sex. So do cinematographers, makeup artists, wardrobe stylists, composers, set designers, casting directors, and even the practical effects department.

And yet somehow, we in the visual effects industry are often forbidden from bringing the sex. Our clients pigeonhole us into the role of the prop maker: Build me a T-rex, and it better look real. But when it comes time to put that T-rex on screen, we are also the cinematographer (with our CG lights), the makeup artist (with our “wet look”
shader), and the practical effects crew (with our rain). And although he may forget to speak with us in the same flowery terms that he used with Dean on set, Steven wants us to make sure that T-rex looks like a T-rex should in a movie. Not just good—impossibly good. Unrealistically blue-rim-light-outa-nowhere good. Sexy good.

Have you ever argued with a client over aspects of an effects shot that were immutable facts? For example, you may have a client who inexplicably requested a little less motion blur on a shot, or who told you “just a little slower” for an object after you calculated its exact rate of fall? Do you ever get frustrated with clients who try to art-direct reality in this way?

Well, stop it.

Your client is a director, and it’s their job to art-direct reality. It’s not their job to know (or suggest) the various ways that it may or may not be possible to selectively reduce motion blur, but it is their job to feel it in their gut that somehow this particular moment should feel “crisper” than normal film reality. And you know what else? It’s your job to predict that they might want this and even propose it. In fact, you’d better have this conversation early, so you can shoot the plate with a 45-degree shutter, that both the actors and the T-rex might have a quarter the normal motion blur.

Was It Good for You?

The sad reality is that we, the visual effects industry, pigeonhole ourselves by being overly preoccupied with reality. We have no one to blame but ourselves. No one else on the film set does this. If you keep coming back to your client with defenses such as “That’s how it would really look” or “That’s how fast it would really fall,” then not only are you going to get in some arguments that you will lose, but you’re actually setting back our entire industry by perpetuating the image of visual effects artists as blind to the importance of the sex. On the set, after take one of the spent brass shell falling to the ground, the DP would turn to the director and say, “That felt a bit fast. Want me to do one at 48 frames?” And the director would say yes, and
they’d shoot it, and then months later the editor would choose take three, which they shot at 72 frames per second “just in case.” That’s the filmmaking process, and when you take on the task of creating that same shot in CG, you need to represent, emulate, and embody that entire process. You’re the DP, both lighting the shot and determining that it might look better overcranked. You’re the editor, confirming that choice in the context of the cut. And until you show it to your client, you’re the director, making sure this moment feels right in all of its glorious unreality.

The problem is that the damage is already done. The client has worked with enough effects people who have willingly resigned themselves to not bringing the sex that they now view all of us as geeks with computers rather than fellow filmmakers. So when you attempt to break our self-imposed mold and bring the sex to your client, you will face an uphill battle. But here’s some advice to ease the process: Do it without asking. I once had a client who would pick apart every little detail of a matte painting, laying down accusations of “This doesn’t look real!”—until we color corrected the shot cool, steely blue with warm highlights. Then all the talk of realism went away, and the shot got oohs and aahs.

Your client reacts to your work emotionally, but they critique technically. When they see your shot, they react with their gut. It’s great, it’s getting better, but there’s still something not right. What they should do is stop there and let you figure out what’s not right, but instead, they somehow feel the need to analyze their gut reaction and turn it into action items: “That highlight is too hot” or “The shadows under that left foot look too dark.” In fact, it would be better if they focused on vocalizing their gut reactions: “The shot feels a bit lifeless,” or “The animation feels too heavy somehow.” Leave the technical details to the pros.

You may think that those are the worst kind of comments, but they are the best. I’ve seen crews whine on about “vague” client comments like “give the shot more oomf.” But trust me, this is exactly the comment you want. Because clients are like customers at a restaurant, and you
are the chef. The client probably wants to believe that “more oomf” translates into something really sophisticated, like volumetric renderings or level-set fluid dynamics, in the same way that a patron at a restaurant would hope that a critique like “this dish needs more flavor” would send the chef into a tailspin of exotic ingredients and techniques. Your client would never admit (or suggest on their own) that “oomf” is usually some combination of “cheap tricks” such as camera shake, a lens flare or two, and possibly some God rays—just like the diner would rather not know that their request for “more flavor” will probably be addressed with butter, salt, and possibly MSG.

The MSG analogy is the best: Deep down, you want to go to a Chinese restaurant that uses a little MSG but doesn’t admit it. You want the cheap tricks because they work, but you’d rather not think about it. Your client wants you to use camera shake and lens flares, but without telling them. They’d never admit that those cheap tricks “make” a shot, so let them off the hook and do those things without being asked. They’ll silently thank you for it. Bringing the sex is all about cheap tricks.

**Lights On or Off?**

There are some visual effects supervisors who pride themselves on being sticklers for detail. This is like being an architect whose specialty is nails. I have bad news for the “Pixel F*ckers,” as this type are known: Every shot will always have something wrong with it. There will forever be something more you could add, some shortcoming that could be addressed. What makes a visual effects supervisor good at their job is knowing which of the infinitely possible tweaks are important. Anyone can nitpick. A good supe focuses the crew’s efforts on the parts of the shot that impact the audience most. And this is always the sex. Audiences don’t care about matte lines or mismatched black levels, soft elements or variations in grain. If they did, they wouldn’t have been able to enjoy *Blade Runner* or *Back to the Future* or that one *Star Wars* movie—what was it called? Oh yeah: *Star Wars*. Audiences only care about the sex.
On a recent film I was struggling with a shot that was just kind of sitting there. It had been shot as a pickup, and it needed some help fitting into the sequence that had been shot months earlier. I added a layer of smoke to technically match the surrounding shots. Still, the shot died on the screen. Finally, I asked my compositor to softly darken down the right half of the shot by a full stop, placing half the plate along with our CG element in a subtle shadow. Boom, the shot sang.

What I did was, strictly speaking, the job of the cinematographer, or perhaps the colorist. The colorist, the person who designs the color grading for a film, is the ultimate bringer of the sex. And color correction is the ultimate cheap trick. There’s nothing fancy about what a Da Vinci 2K or an Autodesk Lustre does with color. But what a good colorist does with those basic controls is bring heaping, dripping loads of sex to the party. The problem is—and I mean the single biggest problem facing our industry today—the colorist gets their hands on a visual effects shot only after it has already been approved. In other words, the film industry is currently shooting itself in the foot (we, the visual effects artists, being that foot) by insisting that our work be approved in a sexless environment. This is about the stupidest thing ever, and until the industry works this out, you need to fight back by taking on some of the role of the colorist as you finalize your shots, just like we did when we made those matte paintings darker and bluer with warm highlights.

Filmmaking is a battleground between those who bring the sex and those who don’t. The non-sex-bringing engineers at Panavision struggle to keep their lenses from flaring, while ever-sexy cinematographers fight over a limited stock of 30-year-old anamorphic lenses because they love the flares. I’ve seen DPs extol the unflinching sharpness of a priceless Panavision lens right before adding a smear of nose grease (yes, the stuff on your nose) to the rear element to soften up the image to taste. Right now this battle is being waged on every film in production between the visual effects department and the colorists of the world. I’ve heard effects artists lament that after all their hard
work making something look real, a colorist then comes along and “wonks out the color.” In truth, all that colorist did was bring the sex that the visual effects should have been starting to provide on their own. If what the colorist did to your shot surprised you, then you weren’t thinking enough about what makes a movie a movie.

**In Your Hands**

You’re holding a book on visual effects compositing in Adobe After Effects. There are those who question the validity of such a thing. Some perpetuate a stigma that After Effects is for low-end TV work and graphics only. To do “real” effects work, you should use a program such as Nuke or Shake. Those techy, powerful applications are good for getting shots to look technically correct, but they do not do much to help you sex them up. After Effects may not be on par with Nuke and Shake in the tech department, but it beats them handily in providing a creative environment to experiment, create, and reinvent a shot. In that way it’s much more akin to the highly respected Autodesk Flame and Inferno systems—it gives you a broad set of tools to design a shot, and has enough horsepower for you to finish it, too.

After Effects is the best tool to master if you want to focus on the creative aspects of visual effects compositing. That’s why this book is unique. Mark’s given you the good stuff here, both the nitty-gritty details as well as the aerial view of extracting professional results from an application that’s as maligned as it is loved. No other book combines real production experience with a deep understanding of the fundamentals, aimed at the most popular compositing package on the planet.

**Bring It**

One of the great matte painters of our day once told me that he spent only the first few years of his career struggling to make his work look real, but that he’ll spend the rest of his life learning new ways of making his work look good. It’s taken me years of effects supervising, commercial directing, photography, wandering the halls of museums, and waking up with hangovers after too much
really good wine to fully comprehend the importance of those words. I can tell you that it was only after this particular matte painter made this conscious choice to focus on making things look good, instead of simply real, that he skyrocketed from a new hire at ILM to one of their top talents. Personally, it’s only after I learned to bring the sex that I graduated from visual effects supervising to become a professional director.

So who brings the sex? The answer is simple: The people who care about it. Those who understand the glorious unreality of film and their place in the process of creating it. Be the effects artist who breaks the mold and thinks about the story more than the bit depth. Help turn the tide of self-inflicted prejudice that keeps us relegated to creating boring reality instead of glorious cinema. Secretly slip your client a cocktail of dirty tricks and fry it in more butter than they’d ever use at home.

Bring the sex.

Stu Maschwitz
San Francisco, October 2008
Introduction
If you aren’t fired with enthusiasm, you will be fired—with enthusiasm.

—Vince Lombardi

Why This Book?

This book is about creating visual effects. Specifically, it dives into the art and science of assembling disparate elements so that they appear as part of a single, believable scene. When people ask me what exactly the book is about, I tell them that it shows artists how to make a shot assembled on a computer look as if it was taken with a single camera. It also hints at how to make an ordinary shot extraordinary, without destroying the viewer’s willing suspension of disbelief.

The subject matter in this book goes well beyond the obvious—and what is well documented elsewhere—and deep into core visual effects topics. We look closely at features such as color correction, keying, tracking, and roto that are only touched on by other books about After Effects, while leaving tools more dedicated to motion graphics (such as Text and Shape layers) largely alone. It’s not that those tools aren’t a powerful part of After Effects; it’s just that they literally don’t fit in this book.

As the author, I do not shy away from strong opinions, even when they deviate from the official line. These opinions and techniques—which have been refined through actual work in production at a few of the finest visual effects facilities in the world—are valid not only for such high-end productions but really anywhere you are compositing a visual effect. Where applicable, the reasoning behind using one technique over another is provided. I aim to make you not a better button-pusher but a more effective artist and technician.

Visual effects companies are typically protective of trade secrets, reflexively treating all production information as
proprietary. Once you work on a major project, however, you will soon discover that even the most complex shot is made up largely of repeatable techniques and practices. The art is in how the results are applied, combined, and customized, and what is added (or taken away). Visual effects artists, meanwhile, can be downright open and friendly about sharing discoveries, knowing that it’s the artistry and not a clever bag of tricks that ultimately make the greatest difference.

Each shot is unique, and yet each relies on techniques that are tried and true. This book offers you as many of the techniques as possible so that you can focus on the unique properties of each shot. There’s not much here in the way of step-by-step instructions—it’s more important for you to grasp how things work so that you can repurpose techniques for your individual shot.

This is not a book for beginners. Although the first section is designed to make sure that you are making optimal use of the software, it’s not an effective primer on After Effects in particular or digital video in general. If you’re new to After Effects, first spend some time with its excellent documentation or check out one of the many books available to help beginners learn the application.

On the other hand, if you’re comfortable with Photoshop and familiar with the visual effects process—which is likely, if you’ve picked up this book—try diving into the redesigned Chapter 1 and let me know how it goes.

Organization of This Book and What’s New

Each edition of the *After Effects Studio Techniques* series has been organized into three sections. Although each chapter has been refined and updated, the broad organization of the book remains as follows.

- Section I, “Working Foundations,” is about After Effects itself, and how to make the most of its user interface. This is not a list of each menu and button but a shortcut to power use when compositing.
If you’re advanced, don’t skip this section. It’s virtually guaranteed to contain valuable information that you don’t already know, and it has been freshened up with new data and figures pertaining to new features in CS6, including the revolutionary Global Performance Cache coverage in Chapter 4.

Section II, “Effects Compositing Essentials,” is about the fundamentals of effects compositing. Color matching, keying, rotoscoping, and motion tracking are the essentials, plus there’s a chapter on the camera and 3D along with another on the expressions used to generate animated data with connections, logic, and math. The final chapter in that section introduces you to 32-bpc linear compositing and high dynamic range imaging pipelines.

This section is the true heart of the book. This edition contains dramatic rewrites of Chapters 7 through 9, due to the many new rotoscoping, tracking, and 3D features added to the application since version CS5.

Section III, “Creative Explorations,” is about the actual shots you are likely to re-create—the bread-and-butter techniques every effects artist needs to know. Some of these examples are timeless, but you will also find a substantial new section to get you up and running with Adobe SpeedGrade, a powerful new tool that most After Effects CS6 artists will have but few know how to use.

In all cases, instead of leading you step-by-step through a single example, the goal is to explain the fundamentals of how things work. You will then be able to put these techniques to use on your own shot, instead of taking a paint-by-numbers approach. While each shot is unique, they can all be grouped together as effectively the same in fundamental ways.

Artistry

While working on the first edition of this book, I would ride my bicycle home up the hill out of the Presidio, where The Orphanage studio was located. As I rode, I thought
about what people really needed to know in order to move their work to the level of a visual-effects pro. Sometimes it was very late at night, when raccoons and skunks would cross my path. Here’s what I came up with:

- **Get reference.** You can’t re-create what you can’t clearly see. Too many of us skip this step and end up making boring, generic choices. Nature is never boring, and if it appears that way, you’re not looking at it closely enough.

- **Simplify.** To paraphrase Einstein, the optimum solution is as simple as possible, but no simpler.

- **Break it down.** Talented but inexperienced students learn how the software works but are not used to analyzing a shot or sequence and breaking it down into manageable, comprehensible steps. This is a book filled with those steps.

- **Learn to take criticism rather than expect perfection.** My former colleague Paul Topolos, now in the art department at Pixar, used to say, “Recognizing flaws in your work doesn’t mean you’re a bad artist. It only means you have taste.” To err is human, to cut yourself a break and keep going, divine.

This is what I learned working at the best studios, and even if you’re not currently working at one of them, this is how collaboration, criticism, and perseverance will be your teachers.

**Compositing in After Effects**

There’s a good reason that Nuke, a node-based compositing application from The Foundry, has almost uniformly become the compositing application of choice at the feature film visual effects studios around the world. Nuke is designed for exactly what those artists need—and only what they need. In some areas, mostly the handling of 3D and stereo, Nuke is clearly ahead of After Effects. In other areas, such as animation and type handling, After Effects has the edge. For compositing fundamentals, the two applications are equally valid, but operations that are simple in Nuke can be complicated in After Effects, and vice versa.
Despite the impression that Nuke has taken over compositing, when you move beyond feature films, After Effects remains the ubiquitous application. They’re both awesome tools, but the important takeaway is that Nuke is specialized while After Effects targets a broader set of users.

Some of the features that streamline After Effects for the generalist and animator (and which, paradoxically, can complicate workflows that are more straightforward for video-effects compositing in Nuke):

- Render order is established in the timeline and via nested compositions that consist of layers, not nodes. After Effects has Flowchart view, but you don’t create your composition there the way you would with a tree/node interface.
- Transforms, effects, and masks are embedded in every layer. They render in a fixed order.
- After Effects has a persistent concept of an alpha channel in addition to the three color channels. The alpha channel is always treated as if it is straight (never premultiplied) once an image has been imported and “interpreted,” as the application terms it.
- An After Effects project is not a script, although version CS4 introduced a text version of the After Effects Project (.aep) file, the XML-formatted .aepx file. Most of the text file’s contents are inscrutable other than source file paths. Actions are not recordable and there is no direct equivalent to Shake macros.
- Temporal and spatial settings tend to be fixed and absolute in After Effects because it is composition- and timeline-based. This is a boon to projects that involve complex timing and animation, but it can snare users who aren’t used to it and suddenly find pre-comp's that end prematurely, are cropped, or don’t scale gracefully. Best practices to avoid this are detailed in Chapter 4.

This book attempts to shed light on these and other areas of After Effects that are not explicitly dealt with in its user interface or documentation. After Effects itself spares you details that a casual user might never need to know about but that, as a professional user, you want to understand thoroughly. This book is here to help.
**What’s on the DVD**

The DVD included with this book provides a variety of helpful resources for the After Effects artist, many provided by friends and colleagues (thanks!).

**Scripting Chapter:** Jeff Almasol’s scripting chapter is now an appendix, found on the disc as a PDF. This highly accessible resource on this complicated and much-feared topic walks you through three scripts, each of which builds upon the complexity of the previous. Scripting provides the ability to create incredibly useful extensions to After Effects to eliminate tedious tasks. Several of these are included in the scripts folder on the disc as exclusives to this book.

A few useful and free third-party scripts mentioned throughout the book are included as well. For more of these, see the script links PDF in the scripts folder on the disc.

**JavaScript Guide:** To focus on more advanced and applied topics in the print edition, Dan Ebberts kicked JavaScript fundamentals to a special JavaScript addendum, also included as a PDF. This is, in many ways, the missing manual for the After Effects implementation of JavaScript. It omits all the useless Web-only scripting commands found in the best available books and extends beyond the material in After Effects help.

**Special-Purpose Topics:** Certain sections that appeared in the print version of previous editions have been moved onto the disc as PDF files. The tools and techniques are still valid, but the material on topics such as morphing, warping, and color management is able to stand on its own to make way for new features that had to be integrated more directly into the rest of the book.

**Footage:** You’ll also find HD footage you can use to experiment on and practice your techniques. There are dozens of example files to help you deconstruct the techniques described.
The Bottom Line

Remember, the tools are just the means for the skilled talented artist to apply the hard work required to inspire an audience with results. By thoroughly learning the tools, you can also learn to think with them, and in so doing, to sort of forget about them as they become second nature. This book will help you do that.
CHAPTER

4

Optimize Projects
Build a system that even a fool can use and only a fool will want to use it.
—George Bernard Shaw

Optimize Projects

This chapter examines in close detail how image data flows through an After Effects project. It’s full of the information you need to help you make the most of After Effects.

Sometimes you take the attitude of a master chef—you know what can be prepped and considered “done” before the guests are in the restaurant and it’s time to cook the meal. At other times, you’re more like a programmer, isolating and debugging elements of a project, even creating controlled tests to figure out how things are working. This chapter helps you both artistically and technically (as if it’s possible to separate the two).

After Effects CS6 received the most substantial performance increase of any single upgrade thanks to Global Performance Cache, a scheme to preserve more individual render data indefinitely, not just when it’s buffered into the RAM cache. This addition doesn’t obviate the need for a solid understanding of how to work with multiple compositions and when to precomp, nor for specific strategies to optimize render time. It does, however, cut down on a good deal of redundancy on the After Effects side of the equation, leaving it up to you to avoid the possibility of PEBKAC (Problem Exists Between Keyboard and Chair).

Work With Multiple Comps and Projects

It’s easy to lose track of stuff when projects get complicated. This section demonstrates

- how and why to work with some kind of project template
- how to keep a complex, multiple-composition pipeline organized
shortcuts to help maintain orientation within the project as a whole.

These tips are especially useful if you’re someone who understands compositing but sometimes finds After Effects disorienting.

**Precomping and Composition Nesting**

Precomping is often regarded as the major downside of working in After Effects, because vital information is hidden from the current comp’s timeline in a nested comp. Artists may sometimes let a composition become unwieldy, with dozens of layers, rather than bite the bullet and send a set of those layers into a precomp. Yet precomping is both an effective way to organize the timeline and a key to problem solving and optimization in After Effects. Motion graphics comps can involve the animation and coordination of hundreds of animated elements. In a visual effects context, however, if your main composition has more than 20 or so layers, you’re not precomping effectively, making work way less efficient overall.

Typically, precomping is done by selecting the layers of a composition that can sensibly be grouped together, and choosing Precompose from the Layer menu (Ctrl+Shift+C/Cmd+Shift+C). Two options appear (the second option is grayed out if multiple layers have been selected): to leave attributes (effects, transforms, masks, paint, blending modes) in place, or transfer them into the new composition.

**Why Precomp?**

Precomping prevents a composition from containing too many layers to manage in one timeline, but it also lets you do the following:

- Reuse a set of elements.
- Fix render order problems. For example, masks are always applied before effects in a given layer, but a precomp can contain an effect so that the mask in the master comp follows that effect in the render order.
- Organize a project by grouping interrelated elements.
Specify an element or set of layers as completed (and even pre-render them, as discussed later in this chapter).

Many After Effects artists are already comfortable with the idea of precomping but miss that last point. As you read through this, think about the advantages of considering an element finished, even if only for the time being.

**The Project Panel: Think of It as a File System**

How do you like to keep your system organized—tidy folders for everything or files strewn across the desktop? Personally, I’m always happiest with a project that is well organized, even if I’m the only one likely to ever work on it. When sharing with others, however, good organization becomes essential. The Project panel mirrors your file system (whether it’s Explorer or Finder), and keeping it well organized and tidy can clarify your thought process regarding the project itself.

I know, I know, eat your vegetables, clean your room. Imagine that the person next opening your project is you, but with a case of amnesia. Actually, that basically is you after a sufficient period of time.

**Figure 4.1** shows a couple of typical project templates containing multiple compositions to create one final shot, although these could certainly be adapted for a group of similar shots or a sequence. When you need to return to a project over the course of days or weeks, this level of organization can be a lifesaver.

Here are some ideas to help you create your own comp template:

- **Create folders**, such as Source, Precomps, and Reference, to group specific types of elements.
- **Use numbering to reflect comp and sequence order** so that it’s easy to see the order in the Project panel.
- **Create a unique Final Output comp** that has the format and length of the final shot, particularly if the format is at all different from what you’re using for work (because it’s scaled, cropped, or uses a different frame rate or color profile).
Use **guide layers and comments** as needed to help artists set up the comp (**Figure 4.2**).

- **Organize Source folders** for all footage, broken down as is most logical for your project.

- Place each source footage clip into a precomp. Why? Unexpected changes to source footage—where it is replaced for some reason—are easier to handle without causing some sort of train wreck.

The basic organization of master comp, source comp, and render comp seems useful on a shot of just about any complexity, but the template can include a lot more than that: custom expressions, camera rigs, color management settings, and recurring effects setups.

**Manage Multiple Comps from the Timeline**

Ever had that “where am I?” feeling when working with a series of nested comps? That’s where Mini-Flowchart, or Miniflow, comes in. Access it via **Shift** in the Timeline panel, or simply tap the **Shift** key with the Timeline panel displayed to enable it.
Chapter 4  Optimize Projects

Miniflow (Figure 4.3) shows only the nearest neighbor comps, but click on the flow arrows at either end and you navigate up or down one level in the hierarchy. Click on any arrows or items in between the ends and that level is brought forward. You’re even free to close all compositions (Ctrl+Alt+W/Cmd+Opt+W) and reopen only the ones you need using this feature.

Figure 4.3  By default, the comp order is shown flowing right to left. The reason for this is probably that if you open subcomps from a master comp, the tabs open to the right; however, you may want to choose Flow Left to Right in Miniflow’s panel menu instead.

What about cases where you’d like to work in the Timeline panel of a subcomp while seeing the result in the master comp? The Lock icon at the upper left of the Composition viewer lets you keep that Composition viewer forward while you open another composition’s Timeline panel and close its view panel. Lock the master comp and double-click a nested comp to open its Timeline panel; as you make adjustments, they show up in the master comp.

Ctrl+Alt+Shift+N (Cmd+Opt+Shift+N) creates two Composition viewers side by side, and locks one of them, for any artist with ample screen real estate who wants the best of both worlds.

To locate a comp in the Project panel, you can

- select an item in the Project panel; click the caret to see where the item is used, along with the number of times, if any, the item is used in a comp (Figure 4.4)

Figure 4.4  Click the caret next to the total number of times an item is used to see a list of where it is used.
context-click an item in the Project panel and choose Reveal in Composition; choose a composition and that comp is opened with the item selected

context-click a layer in the timeline and choose Reveal Layer Source in Project to highlight the item in the Project panel

context-click in the empty area of a timeline—and choose Reveal Composition in Project to highlight the comp in the Project panel (Figure 4.5)

type the name of the comp in the Project panel search field.

Ways to Break the Pipeline

Precomping solves problems, but it can also create more problems—or at least inconveniences. Here are a few ways that render order can go wrong:

Some but not all properties are to be precomped, but others must stay in the master comp? With precomping it’s all-or-nothing, leaving you to rearrange properties manually.

Changed your mind? Restoring precomped layers to the master composition is a manual (and thus error-prone) process, due to the difficulty of maintaining proper dependencies between the two (for example, if the nested comp has also been scaled, rotated, and retimed).

Do the layers being precomped include blending modes or 3D layers, cameras, or lights? Their behavior changes depending on the Collapse Transformations setting (detailed in the next section).

Is there motion blur, frame blending, or vector artwork in the subcomp? Switches in the master composition affect their behavior, as do settings on each individual nested layer, and this relationship changes depending on whether Collapse Transformations is toggled on.

Layer timing (duration, In and Out points, frame rate) and dimensions can differ from the master comp. When this is unintentional, mishaps happen: Layers end too soon or are cropped inside the overall frame, or keyframes in the precomp fall between those of the master, wreaking havoc on tracking data, for example.

Figure 4.5 Find the empty area below the layers in the timeline and context-click; you can reveal the current comp in the Project panel.

You may already know that a double-click opens a nested comp, and Alt–double-click (Opt–double-click) reveals it in the Layer viewer.

The script preCompToLayerDur.jsx from Dan Ebberts (found on the book’s disc) starts a precomped layer at frame 1 even if the layer to be precomped is trimmed to a later time.
Optimize Projects

Are you duplicating a comp that contains subcomps? The comp itself is new and completely independent, but the nested comps are not (see Script on this page). No wonder people avoid precomping. But there is hope if you recognize any difficulty and know what to do, so that inconveniences don’t turn into deal-killers.

Boundaries of Time and Space

Each composition in After Effects contains its own fixed timing and pixel dimensions. This adds flexibility for animation but if anything reduces it for compositing. Most other compositing applications such as Nuke and Shake have no built-in concept of frame dimensions or timing and assume that the elements match the plate, as is often the case in visual effects work.

Therefore it is helpful to take precautions:

- Make source compositions longer than the shot is ever anticipated to be, so that if it changes, timing is not inadvertently truncated.
- Enable Collapse Transformations for the nested composition to ignore its boundaries (Figure 4.6).
- Add the Grow Bounds effect if Collapse Transformations isn’t an option (see sidebar on next page).

Collapse Transformations is the most difficult of these to get your head around, so it’s worth a closer look.

Collapse Transformations

In After Effects, when a comp is nested in another comp, effectively becoming a layer, the ordinary behavior is for the nested comp to render completely before the layer is animated, blended, or otherwise adjusted (with effects or masks) in the master comp.

However, there are immediate exceptions. Keyframe interpolations, frame blending, and motion blur are all affected by the settings (including frame rate and timing) of the master comp—they are calculated according to its settings (which can become tricky; see the next section). 3D position data and blending modes, on the other hand, are not passed through unless Collapse Transformations is
enabled. Enable the toggle and it is almost as if the pre-composed layers reside in the master comp—but now any 3D camera or lighting in the subcomp is overridden by the camera and lights in the master comp.

Not only that, but layers with Collapse Transformations lose access to blending modes—presumably to avoid conflicts with those in the subcomp. Now here comes the trickiest part: Apply any effect to the layer (even Levels with the neutral defaults, which doesn’t affect the look of the layer) and you force After Effects to render the collapsed layer, making blending modes operable. It is now what the Adobe developers call a parenthesized comp. Such a nested comp is both collapsed and not: You can apply a blending mode, but 3D data is passed through (Figure 4.7).

To collapse transformations but not 3D data, apply any effect—even one of the Expression Controls effects that don’t by themselves do anything—to parenthesize the comp.

Figure 4.7 You’re not supposed to be able to apply blending modes to ray-traced 3D scenes. You can precomp such a scene and enable Collapse Transformations so that all of its ray-traced 3D qualities are passed through, but you still can’t apply a blending mode such as Add (shown here). However, if you add a simple effect such as Levels, unadjusted, transformations and shading are still passed through, but they no longer interact in 3D with the master comp.
Nested Time

After Effects is not rigid about time, but digital video itself is. You can freely mix and change frame rates among compositions without changing the timing, as has been shown. However, because your source clips always have a very specific rate, pay close attention when you

- import an image sequence
- create a new composition
- mix comps with different frame rates.

In the first two cases, you’re just watching out for careless errors. But you might want to maintain specific frame rates in subcomps, in which case you must set them deliberately on the Advanced tab of the Composition Settings dialog.

Advanced Composition Settings

In addition to the Motion Blur settings covered in detail in Chapter 8, Composition Settings > Advanced contains two toggles that influence how time and space are handled when one composition is nested into another.

Preserve Frame Rate maintains the frame rate of the composition wherever it goes—into another composition with a different frame rate, or into the render queue with different frame rate settings. So if a simple animation cycle looks right at 4 frames per second (fps), it won’t be expanded across the higher frame rate, but will preserve the look of 4 fps.

Preserve Resolution When Nested controls what is called concatenation. Typically, if an element is scaled down in a precomp and the entire composition is nested into another comp and scaled up, the two operations are treated as one, so that no data loss occurs via quantization. This is concatenation, and it’s usually a good thing. If the data in the subcomp is to appear pixilated, as if it were scaled up from a lower-resolution element, this toggle preserves the chunky pixel look.

Special Case: Adjustment and Guide Layers

Two special types of layers, adjustment and guide layers, offer extra benefits that might not be immediately apparent, and are often underused.
Adjustment Layers

From a nodal point of view, adjustment layers are a way of saying “at this point in the compositing process, I want these effects applied to everything that has already rendered.” Because render order is not readily apparent in After Effects until you learn how it works, adjustment layers can seem trickier than they are.

The *adjustment layer* is itself invisible, but its effects are applied to all layers below it. It is a fundamentally simple feature with many uses. To create one, context-click in an empty area of the Timeline panel, and choose New > Adjustment Layer (Ctrl+Alt+Y/Cmd+Opt+Y) (Figure 4.8).

Adjustment layers allow you to apply effects to an entire composition without precomping it. That by itself is pretty cool, but there’s more:

- Move the adjustment layer down the stack and any layers above it are unaffected, because the render order in After Effects goes from the lowest layer upward.
- Shorten the layer and the effects appear only on frames within the adjustment layer’s In/Out points.
- Use Opacity to attenuate any effect; most of them work naturally this way. Many effects do not themselves include such a direct control, even when it makes perfect sense to “dial it back 50%,” which you can do by setting Opacity to 50%.
- Apply a matte to an adjustment layer to hold out the effects to a specific area of the underlying image.
- Add a blending mode and the adjustment layer is first applied and then blended back into the result (Figure 4.9).

It’s a good idea 99% of the time to make sure that an adjustment layer remains 2D, and you will most often also want it to be the size and length of the comp, as when applied. It’s rare that you would ever want to move, rotate, or scale an adjustment layer in 2D or 3D, but it is possible to do so accidentally. If you enlarge the composition, resize the adjustment layers as well.

![Figure 4.8](image1.png)

*Figure 4.8* The highlighted column includes toggle switches, indicating an adjustment layer. Any layer can be toggled, but the typical way to set it is to create a unique layer. An adjustment layer created under Layer > New > Adjustment Layer (or via the shortcuts) is a white, comp-sized solid.

![Figure 4.9](image2.png)

*Figure 4.9* Here, the source plate image (a) is shown along with two alternates in which Camera Lens Blur has been applied via an adjustment layer, held out by a mask. With the adjustment layer blending mode set to Normal (b), there is a subtle bloom of the background highlights, but changing it to Add (c) causes the effect to be applied as in (b) and then added over source image (a).
Guide Layers

Like adjustment layers, guide layers are standard layers with special status. A guide layer appears in the current composition but not in any subsequent compositions or the final render (unless it is specifically overridden in Render Settings). You can use this for

- foreground reference clips (picture-in-picture timing reference, aspect ratio crop reference)
- temporary backgrounds to check edges when creating a matte
- text notes to yourself
- adjustment layers that are used only to check images (described further in the next chapter); a layer can be both an adjustment and a guide layer.

Any image layer can be converted to a guide layer either by context-clicking it or by choosing Guide Layer from the Layer menu (Figure 4.10).

Figure 4.10 Check out all the guide layers that won’t render, but do help you work: One pushes up gamma to check blacks, and two provide crops for different aspects (1.85:1 and 2.35:1, the common cinematic formats). A picture-in-picture layer shows timing reference from the plate, along with a text reminder that does not render. None of this is visible in another composition or in the render.
Image Pipeline, Global Performance Cache, and Render Speed

The render pipeline is the order in which operations happen; by controlling it, you can solve problems and overcome bottlenecks. For the most part, render order is plainly displayed in the timeline and follows consistent rules:

- 2D layers are calculated from the bottom to the top of the layer stack—the numbered layers in the timeline.
- Layer properties (masks, effects, transforms, paint, and type) are calculated in strict top-to-bottom order (twirl down the layer to see it).
- 3D layers are instead calculated based on distance from the camera; coplanar 3D layers respect stacking order and should behave like 2D layers relative to one another.

So to review: In a 2D composition, After Effects starts at the bottom layer and calculates any adjustments to it in the order that properties are shown, top to bottom. Then, it calculates adjustments to the layer above it, composites the two of them together, and moves up the stack in this manner (Figure 4.11). Although effects within a given layer are generally calculated prior to transforms, an adjustment layer guarantees that its effects are rendered after the transforms of all layers below it.

Track mattes and blending modes are applied last, after all other layer properties (masks, effects, and transforms) have been calculated, and after their own mask, effect, and transform data are applied. Therefore, you don’t generally need to pre-render a track matte simply because you’ve added masks and effects to it.

Global Performance Cache: Way Faster!

We’re over 100 pages into the book and just now getting into the most revolutionary addition to the latest version of After Effects. You don’t technically need a book to experience what can be extraordinary benefits from how After Effects CS6 preserves your work in progress for instant playback; you probably already know and love this feature, but as a reader of a book like this you probably also want

Figure 4.11 2D layers render starting with the bottom layer, rendering and compositing each layer above in order. Layer properties render in the order shown when twirled down; there is no direct way to change the order of these categories.

TIP

3D calculations are precise well below the decimal level but do round at some point. To avoid render errors, precomp them in a nested 2D layer.

TIP

The Transform effect allows you to position, scale, or rotate a layer before other effects are applied, solely to avoid precomping.

Although After Effects doesn’t prohibit you from doing so, don’t apply a track matte to another track matte and expect consistent results. Sometimes it works, but it’s not really supposed to work, and most often it doesn’t.
to know as much as you can about how it works so you can maximize what it does for you.

The feature name “Global Performance Cache” is a generic term for what is, in fact, a set of interrelated technologies:

- a Global RAM cache that is smarter about dividing your work to save as many individual processes as possible
- a persistent disk cache that saves those precalculated processes for continual reuse
- an updated graphics pipeline that makes greater use of OpenGL to present and stream images onscreen, including the UI overlays that are a constant when working in After Effects

You have to hand it to the After Effects development team here. Engineers too easily assume they need to tear technology apart and rebuild it from scratch in order to modernize it. Global Performance Cache is the result of looking at what modern hardware can deliver that simply was not possible a few years ago, and figuring out how to make use of that hardware:

- **cheap and plentiful RAM**, and the ability of a 64-bit operating system to access far more of it (up to 192 GB on Windows 7, and well in excess of the 2 GB per processor core recommended for After Effects)
- **fast attached storage**, including SSD drives that routinely double the access speed of even the fastest HDD drive or array
- **high-end graphics cards** with GPUs that accelerate performance year after year at rates that way, way outstrip Moore’s Law

In the past, After Effects has rather notoriously failed to take advantage of these advantages. Lots of RAM is no good if your RAM preview disappears each time you make an edit; fast storage doesn’t mean spacebar play of a timeline in real-time; and until CS6, the high-end graphics card that you purchased to work in Maya or CINEMA 4D hardly made a dent in After Effects interactivity.

Each of these areas of performance is directly addressed in After Effects CS6. The result is completely subjective, but
can be quantified as a routine 10–20x acceleration of RAM previews. Depending on how often you review playback during your workday, this means either you can keep working that much faster, or the whole way that you work with the application is changed.

**Memory Acceleration: Global RAM Cache**

After Effects has always loved plenty of RAM, but until CS6 it used it in a much more brute-force way. You have always needed lots of RAM to store and play back a given large-format clip using physical memory and perform operations on that large frame. The brute-force part is that as soon as you made even a teeny change to all of that cached data, it all tended to be blown away, only to be recreated more or less from scratch the next time you previewed a frame or sequence.

By slicing a clip with its many selections and effects into discrete chunks and storing each of those render steps individually, After Effects CS6 greatly reduces the amount of re-rendering of cached footage. You can change a given effect setting or range of keyframes without disrupting other parts of the image and clip that are unrelated to that change.

Reusable frames are recognized anywhere on the timeline: when you use loop expressions (Chapters 8 and 10), remap time, or copy and paste keyframes. Duplicated layers or whole duplicated comps are also recognized.

The net result is that you can try something, preview the result without rendering from scratch, and undo the change without penalty. Since this, in essence, is how you spend your working day as an After Effects artist, the resulting 5–15x speed increase ripples throughout the process, allowing you not only to get to a result more quickly but to try more options without worrying about the time cost.

This tends to work a lot better with 2D layers than with a ray-traced 3D comp. It is easy to consider an effect or setting in a 2D layer to be an island unto itself, but in 3D, light, reflection, shadows, refraction, and translucency are all considered to be influenced by the adjustment of a single element such as a light or the position of a layer.
Continuous Access: Persistent Disk Cache

Data in the RAM cache is now much less fragile because it is constantly backed up in a persistent disk cache. If you run out of RAM, increment and save to a new version of the project, or even quit the application and reopen the project. Its cache is available for instant playback and immediate rendering (Figure 4.12b).

Persistent disk cache is also the most tweakable of the Global Performance Cache options, and the one for which your choice of hardware may make the greatest difference. Here’s a list of the most effective tweaks, followed by a breakdown:

- dedicate fast attached storage to the After Effects cache
- use the Cache Work Area in Background command as you work
- incorporate Dynamic Link with Premiere Pro
- render locally

Figure 4.12 With Layer Cache Indicators on, you begin to see how After Effects breaks down the RAM cache into individual layers and even effects (a). With fast attached storage, you will see those green lines turn blue as they move from RAM to the disk (b).
Before drawing out the first three points in more detail, note that the persistent disk cache cannot be considered sharable or portable. Place the cache on a shared drive and point two systems to it and all you do is introduce the likelihood of instability; the two systems will not recognize those cached files in the same way and will simply continue to generate their own cache data. This data is designed to be accessed instantly and is cleverly designed to track a given comp and layers even as project versions change on a given system (Figure 4.13).

This is not to say that I haven’t tried and succeeded at replacing the disk cache on a given system with one that’s already preloaded with a bunch of rendered frames and effects, but I wouldn’t make that standard practice. The disk cache is designed to be local to a given system. The benefit is that a cached comp may render faster locally than it will even on a large render network. The downside, if you want to think of it that way, is that the render network has essentially no opportunity to take advantage of a disk cache, at least not on the first pass.

**Disk Cache Boost 1: Get Fast Attached Storage**

The permanent disk cache can be a little like a huge RAM extension providing much longer memory and far greater capacity. As such, it’s in your interest to maximize its performance and, if possible, capacity. Why? Not only because faster is better; After Effects actively evaluates whether it’s in the application’s best interests to commit a given process to disk. The greater the difference between processor and cache speed, the more likely a frame gets the blue cache indicator, ready to turn green at any time (and the faster it turns green, ready for real-time).

Let’s start at the low end, with you laptop people. I know, I know, you are the cutting edge. But your single, slow hard disk drive will make you long for something better—something like a dedicated solid state drive, which at this writing is sparking a laptop evolution in which nearly useless DVD drives are replaced with a sled holding a high-capacity SSD. Yes, there is a cost involved. It will also set you free.
At the other end—the high one—the release of After Effects CS6 coincided neatly with the debut of Fusion ioFX (Figure 4.14). It’s not easy to quantify, but it’s being regarded in After Effects circles as something like a half-terabyte extension to SDRAM, with the disk cache ready to fill it with your inspirations and missteps alike. It’s all part of the process, and way less hard on your body than amphetamines, which never let you get out of the studio in time for a dinner date.

And in the middle, that striped RAID array you have attached to your system is still going to help you a bunch. Any drive other than the internal boot drive will work better, and if you edit footage professionally, you already have just such a dedicated drive available.

Bottom line? Everyone wins. Even on a laptop you can see 10–15x speed increases that will make you hungry to feed the disk cache more and faster storage space.

**Disk Cache Boost 2: Commit a Comp**

Disk caching in After Effects need not be a passive response, like Aslan, only appearing when not expected and most needed. It’s true, you get all of the subcomps associated with the comp that you cache committed to disk as well (assuming After Effects judges them faster to render if committed to storage), so caching a master comp gets you a lot of free material to work with. But sometimes, for whatever reason, that master comp doesn’t commit to disk when previewed, or more often, it needs way longer to render than you want to wait watching it draw frames.

I just realized as I typed the last sentence that the days of waiting and watching a RAM preview progress frame by frame could, in fact, be completely over if you want them to be. Composition > Cache Work Area in Background (Ctrl/Cmd+Return) renders a comp into the disk cache while you continue to work.

If you really hate waiting for a comp to preview, and have a half-decent system and something better to do with your time, you can select a whole set of comps in the Project panel and cache them. Yes, if you’re on a non-CUDA-enabled Macbook Pro and those comps are all full of HD
ray-traced 3D animations, your system is going to sound like a jet preparing for takeoff and your laptop will scorch your lap. On the other hand, if you’re on one of those systems that has more processor cores than you can count when you open up their little capacity meters in the system, well, you are finally going to get your money’s worth.

Caveats? Downsides? You gotta pay to play. This is where gobs of low-latency storage is going to be your new best friend, other than the actual best friend that you get to spend time with when you are done for the day and not already burning the midnight oil. But there’s always that CBB.

Disk Cache Boost 3: Rethink Dynamic Link

Odds are better than even that, alongside After Effects, sit a number of other apps (or programs as you Windows people and characters in Tron apparently call them) that also begin with the word “Adobe.” Go ahead, take a look, I’ll wait.

Oh, you’re back! And you have just discovered that fully half the contents of the applications (programs) begin with A? Welcome to the world of video, in which company names start with A. While you wonder why you installed Flash Builder with no plans to build anything in Flash, go back, scroll down, and note the little nonlinear editor that could. I’m talking about Premiere Pro.

No longer solely the favorite among wedding videographers (and I say that with no disrespect, but let’s face it, After Effects is not big with that group), Premiere Pro CS6 has become many people’s favorite NLE, mine included. Like many others, I treated Premiere Pro as a utility, not a place I wanted to spend time working, and for me the CS6 version changes that. I find that I actually like working in it.

Premiere Pro has a unique ability to link directly to an After Effects comp. Dynamic Link is a feature that allows Adobe Premiere Pro to actually look inside an After Effects project for an existing comp that it can import (Figure 4.15), or designate a clip in a sequence as the basis for a new After Effects comp.
With either approach, there is an actual, live After Effects comp sitting in a Premiere Pro sequence. After Effects invisibly provides the ability to render it, headlessly, in the background. As any change is made to the comp on the After Effects side, it remains up to date in the Premiere edit.

In the past, the difficulty with this approach has been that Premiere Pro has no real concept of render management, and the steps that you take for granted to make a preview render faster in After Effects, working at half or quarter resolution, aren’t available. Imagine that every time you wanted to play something back, you had to render it at full resolution.

If you’re thinking that Global Performance Cache helps in such a case, you are correct. Suppose you have a heavy comp that requires 10 seconds to render each frame at full resolution. If you cache the comp at full, Premiere Pro has access to those cached frames even if After Effects isn’t open. Render the sequence and that clip is ready for real-time playback in seconds, not minutes or hours.

Note that you do, however, still have to render to get rid of the red line above that clip, even if it’s completely cached at full resolution. And, when you do so, it doesn’t add to the After Effects cache. The way to make this work is to generate a preview in After Effects. This still requires you
to perform an edit, but once you do so, it helps speed up the Premiere Pro timeline just as it does in After Effects.

**Proxies, Previews, and Network Renders**

Previous editions of this book advocated the use of proxies and previews as ways to accelerate the previewing and rendering process. This is exactly where Global Performance Cache changes the game, but only as long as you work on the “one artist, one project, one system” model, given that the cache is neither portable nor sharable.

For this reason, the old ways are still valid in any case where a project needs to be moved or shared, even if only for rendering purposes. The good news is that the cached data helps even this process to happen much more efficiently, because it is also used to render on the system that generated it.

**Post-Render Options**

Tucked away in the Render Queue panel, but easily visible if you twirl down the arrow next to Output Module, is a menu of three post-render actions to incorporate a render into a project. After the render is complete, you can use

- **Import** simply to bring the result back into the project
- **Import & Replace Usage** to replace the usage of the source comp in the project without blowing it away
- **Set Proxy** to add a proxy to the source (the most elegant solution, but the most high-maintenance)

The latter two options even let you use the pick whip icon adjacent to the menu to connect whatever item in the Project panel needs replacement. If you’ve already created a pre-render or proxy, you can target that (Figure 4.16).

**Proxies and Pre-Renders**

Let’s face it, dutifully rendering proxies is boring and will seem completely unnecessary with all of the new cache features—right up until the moment when you’re in a rush and no longer have access to that cache, either when rendering remotely or handing off the project. Are you willing to buy some insurance on that cache? If so, this section is for you.
Chapter 4  Optimize Projects

Any image or clip in your Project panel can be set with a proxy, which is an imported image or sequence that stands in for that item. Its pixel dimensions, color space, compression, even its length and frame rate, can differ from the item it replaces. You can have a quick-and-dirty still or low-res, compressed, low-frame-rate clip stand in for a render-heavy comp.

To create a proxy, context-click an item in the Project panel and choose Create Proxy > Movie (or Still). A render queue item is created and, by default, renders at Draft quality and half-resolution; the Output Module settings create a video file with alpha, so that transparency is preserved and Post-Render Action uses the Set Proxy setting.

Figure 4.16  Virtually any project item can be the target for replacement or a proxy; click and drag the pick whip icon to choose the item to be replaced by the render.

Figure 4.17  The black square icon to the left of an item in the Project panel indicates that a proxy is enabled; a hollow square indicates that a proxy is assigned but not currently active. Both items are listed atop the Project panel, the active one in bold.

To remove a proxy from a project, select the item or items with proxies, context-click (or go to the File menu), and choose Set Proxy > None.

Any image or clip in your Project panel can be set with a proxy, which is an imported image or sequence that stands in for that item. Its pixel dimensions, color space, compression, even its length and frame rate, can differ from the item it replaces. You can have a quick-and-dirty still or low-res, compressed, low-frame-rate clip stand in for a render-heavy comp.

To create a proxy, context-click an item in the Project panel and choose Create Proxy > Movie (or Still). A render queue item is created and, by default, renders at Draft quality and half-resolution; the Output Module settings create a video file with alpha, so that transparency is preserved and Post-Render Action uses the Set Proxy setting.

Figure 4.17 shows how a proxy appears in the Project panel. Although the scale of the proxy differs from that of the source item, it is scaled automatically so that transform settings remain consistent. This is what proxies were designed to do: allow a low-resolution file to stand in, temporarily and nondestructively, for the high-resolution final.

There’s another use for proxies. Instead of creating low-res temp versions, you can instead generate final quality pre-rendered elements. With a composition selected, choose Composition > Pre-render and change the settings to Best for Quality and Full for Resolution, making certain that Import and Replace Usage is set for Output Module.
Here’s the key. By default, the source file or composition is used to render unless specifically set otherwise in Render Settings > Proxy Use. Choose Use Comp Proxies Only, Use All Proxies, or Current Settings (Figure 4.18) and proxies can be used in the final render.

**Background Renders**

Rendering from the render queue ties up the application and much of the machine’s processing power, which used to mean that renders were left until lunchtime or off-hours. On a modern system with multiple processors, you can do much better than that (but take breaks anyway, they’re good for you).

*Adobe Media Encoder*

It is easily overlooked that Adobe provides a background rendering application. Adobe Media Encoder (AME) has, for a couple of versions, been the best option to render certain video formats optimally—including Flash video (FLV and F4V), H.264, and MPEG-2—that don’t work well with the frame-by-frame rendering model of After Effects. H.264, for example, is a “long GOP” format that relies on keyframes with lots of image data surrounded by in-between frames containing only shorthand for the changes for those keyframes, and it requires all of the frames to be rendered before it can work its magic. Only Adobe Media Encoder collects frames to compress them, and offers the option to render an After Effects comp on two passes.

Drag and drop an After Effects project into Adobe Media Encoder and you are able to look inside the project for renderable comps (Figure 4.19). You then choose render settings by either selecting them from the Preset Browser.

![Figure 4.18](image)

Typically set Proxy Use to Current Settings, but Use Comp Proxies Only lets you set low-res stand-ins for footage and full-resolution pre-renders for comps, saving gobs of time.
Chapter 4  Optimize Projects

Figure 4.19 Dynamic Link allows other Adobe applications to see your Project panel; Adobe Media Encoder uses this to let you render comps for heavily compressed video formats directly from the project.

or customizing the settings by clicking on the Preset for the render item and specifying your own (which you can then save as a preset).

The best thing about Adobe Media Encoder, in addition to multipass rendering, is that it provides the option to render in the background while you continue to work in After Effects, which a regular render doesn’t permit. The challenge to AME is that it has a lot of presets without a lot of clues to which is the best for your situation. Worst of all, the layout for these settings is unfamiliar if you are accustomed to After Effects, and that alone stops a lot of people.

aerender

Background rendering allows a render to occur without the user interface, allowing you to continue working with it. The aerender application is found alongside the After Effects CS6 application on your system but runs via a command line (in Terminal Unix shell on Mac OS, or the command shell in Windows). You can drag it into the shell window to run it, or press Enter (Return) to reveal its Unix manual pages. This lists the arguments that can be added in quotes to the command aerender, and the location string of the project file.
But that’s all such geeky gobbledygook when you have the BG Render script, which gives you access to all of these options via a panel in the After Effects UI, with no need to type any code.

**Network Rendering**

The `aerender` command is also used by third-party rendering solutions that work a lot like BG Renderer but are distributed across multiple machines on a network. These programs can manage renders on multiple machines and do tricky stuff like pause a render until an updated element from 3D is done, or automatically re-queue failed renders. Because these third-party rendering options—Rush Render Queue, Pipeline’s Qube!, Überware’s Smedge, or Muster by Virtual Vertex, to name a few—also support other terminal-friendly applications such as Maya and Nuke, it’s an investment facilities that are large enough to have a render farm don’t have to think twice about making.

These are not one-click installs and they’re generally justified only by dedicated machines and a dedicated nerd to manage it all. If that’s beyond your facility at this point, you can still take advantage of all of this technology via the Cloud, or via a service such as Render Rocket. You upload your source files and get back rendered output. The downside for compositors is that we generally require a lot of source data to produce final shots, compared with 3D artists who can sometimes create a final cinematic image with virtually no source.

**Watch Folder**

The myopic and slightly dotty granddaddy of network rendering on After Effects is Watch Folder (File > Watch Folder). Watch Folder looks in a given folder for projects ready to be rendered; these are set up using the Collect Files option. The Adobe Help topic “Network rendering with watch folders and render engines” includes everything you need to know.

Watch Folder is kind of okay on small, intimate networks, but it requires much more hands-on effort than dedicated
render management software, and it breaks easily, at which point it requires human intervention. Since individual systems have become so powerful, it’s easy to become lazy about taking the trouble required to set up a Watch Folder render, but if you’re up against a deadline, don’t have the dedicated software, and want to maximize multiple machines, it will do the trick.

**Optimize a Project**

Here are a few more workflow tweaks to get the best performance out of After Effects.

**Hack Shortcuts, Text Preferences, or Projects**

Some people are comfortable sorting through lines of code gibberish to find editable tidbits. If you’re one of those people, After Effects Shortcuts and Preferences are saved as text files that are fully editable and relatively easy to understand. Unless you’re comfortable with basic hacking (learning how code works by looking at other bits of code), however, I don’t recommend it. The files are located as follows:

- **Windows**: `drive:`\Users\[user name]\AppData\Roaming\Adobe\After Effects\11.0\`
- **Mac**: `drive:`\Users\[user profile]\Library\Preferences\Adobe\After Effects\11.0/`

Mac OS X started hiding the User/Library folder with the release of 10.7 (Lion). The easiest way to reveal it from the Finder is to select Go > Go to Folder and then type `Library`. The names of the files are

- **Adobe After Effects 11.0-x64 Pref.txt**
- **Adobe After Effects 11.0 Shortcuts**

These can be opened with any text editor that doesn’t add its own formatting and works with Unicode. Make a backup copy before editing by simply duplicating the file (any variation in the filename causes it not to be recognized by After Effects). Revert to the backup by giving it the original filename should anything start to go haywire after the edit.

The Shortcuts file includes a bunch of comments at the top (each line begins with a `#` sign). The shortcuts

---

**Setting Preferences and Project Settings**

Here are a few default preferences I always change:

- **Preferences > General > Levels of Undo**: Got RAM? Set this to 99.
- **Preferences > General**: Check the options to Allow Scripts to Write Files and Access Network.
- **Preferences > General**: Toggle Default Spatial Interpolation to Linear.
- **Preferences > General**: Dynamic Link with After Effects Uses Project File Name with Highest Number.
- **Preferences > Display**: Check all four boxes (unless you love those little thumbnails; they can slow you down on a network).
- **Preferences > Import**: 29.97 for broadcast, 24 fps for film, 23.976 for both (film for broadcast), and 25 fps for PAL-derived systems.
- **Preferences > Media & Disk Cache**: Choose a folder on a fast, attached disk.
- **Preferences > Appearance**: Cycle Mask Colors; on.
- **Preferences > Auto-Save**: On.
themselves are arranged in a specific order that must be preserved, and if you add anything, it must be substituted in the exact right place.

Be extra careful when editing Preferences—a stray character in this file can make After Effects unstable. Most of the contents should not be touched, but here’s one example of a simple and useful edit (for studios where a dot is preferred before the number prefix instead of the underscore): Change

"Sequence number prefix" = "."

to

"Sequence number prefix" = "_" 

This is the format often preferred by Maya, for example.

In other cases, a simple and easily comprehensible numerical value can be changed:

"Eye Dropper Sample Size No Modifier" = "1"
"Eye Dropper Sample Size With Modifier" = "5"

In many cases, the value after the = is a binary yes/no value, expressed as 0 for no and 1 for yes, so if you’re nostalgic for how the After Effects render chime sounded in its first several versions, find

"Play classic render chime" = "0"

and change the 0 to a 1. Save the file, restart After Effects, and invoke those 20th-century glory days of the beige Mac. Ask an After Effects veteran sometime what that chime evokes, and get ready to buy that warrior a beer.

**XML**

After Effects projects can be saved as .aepx files. These work the same way but are written in plain Unicode text; you can edit them with an ordinary text editor. Most of what is in these files is untouchable; the main use is to locate and change file paths to swap footage sources without having to do so manually in the UI. If that means nothing to you, you’re probably not the shell scripting nerd for whom a feature like that was created.
Chapter 4  Optimize Projects

Chapter 1 included advice about running After Effects with multiprocessing enabled on a system with multiple cores and a good deal of physical memory. If you see your system’s wait icon come up—the hourglass in Windows, the spinning ball on a Mac—that means there is a fight going on somewhere for system resources. In addition to following the advice in Chapter 1 to leave memory available for outside applications, you may have to quit any application that is both resource-intensive and outside the memory pool managed by After Effects (in other words, any app besides Adobe Premiere Pro, Encore, Prelude, Adobe Media Encoder, or Photoshop).

Memory Management

Chapter 1 included advice about running After Effects with multiprocessing enabled on a system with multiple cores and a good deal of physical memory. If you see your system’s wait icon come up—the hourglass in Windows, the spinning ball on a Mac—that means there is a fight going on somewhere for system resources. In addition to following the advice in Chapter 1 to leave memory available for outside applications, you may have to quit any application that is both resource-intensive and outside the memory pool managed by After Effects (in other words, any app besides Adobe Premiere Pro, Encore, Prelude, Adobe Media Encoder, or Photoshop).
The best idea is to provide the system with more physical memory. As a rule of thumb, 2 GB of RAM per processor core is not a bad guide. You can go below this to, say, 1.5 GB per core, but much lower and your system will be less efficient unless you also limit the number of cores After Effects uses (in Preferences > Memory & Multiprocessing).

These Are the Fundamentals

You’ve reached the end of Section I (if you’re reading this book linearly, that is), and we’ve done everything we could think of to raise your game with the After Effects workflow. Now it’s time to focus more specifically on the art of visual effects. Section II, “Effects Compositing Essentials,” will teach you the techniques, and Section III, “Creative Explorations,” will show you how they work in specific effects situations.

So here comes the fun part.
This page intentionally left blank
Symbols
- (decrement operator), in JavaScript, 327
* (asterisk) key, in Timeline, 38

Numbers
1.0 gamma (linear) color blending
   in fire composites, 441
   in HDR compositing, 354, 364–365
   in multipass rendering, 402
   in Project Settings, 360, 402, 441
   in selections, 92, 94
2D
   adjustment layers in, 111, 113
   animation in, 44–50
   caching compositions in, 117
   Corner Pin tracking in, 253
   liquid layers in, 415
   previewing compositions in, 115
   tracking motion between 3D and, 334–340
2K plates, 22
3D
   anchor points in, 55
   caching compositions in, 117
   focal depth in, 294–296
   glasses, 280–282
   layers in, 274–278
   monitors, 282
   Motion Blur for animation in.
      See Motion Blur
   multipass compositing in, 399–404
   nulls in, 260–261
   previewing compositions in, 115
   ray-based, extruded, 274–276
   ray-traced, 24
   stereoscopic. See stereoscopic
      3D integration
      tracking data in, 259–260
      tracking motion between 2D and, 334–340
3D Camera Tracker
   introduction to, 226–227
   mocha AE planar tracker vs., 257
   refining camera track in, 229–231
   Roto Brush and, 230–231
   tracking scenes with, 227–229
   unsolvable shots in, 231–232
3D LUTs (look-up tables). See also
   LUTs (look-up tables)
   Cineon log files and, 353
   in linear LDR compositing, 367
4:3 aspect ratio, 313–314
8-bpc (bits per channel)
   color correction in, 143, 154
   color mode in, 345–347
   effects in HDR compositing, 364
   luminance values in, 367
   RGB values in, 349, 367
10-bit Cineon .dpx files, 347
16-bpc (bits per channel)
   color correction in, 153
   effects in HDR compositing, 364
   HDR composites in, 345–346
   16 mm film, 347
16:9 widescreen format, 313–314
   23.976 fps (frames per second), 331
   24 fps (frames per second)
      in film footage, 19
      in videotape, 313
   Warp Stabilizer and, 242
   29.97 fps (frames per second), 313
   30 fps (frames per second), 6
   32-bpc (bits per channel)
      blending colors, 364–365
      Compander for, 363–364
      in HD compositing, 363–366
      in linear HDR compositing, 361–363
      mixed bit depths and, 363–364
      output of, 366
      selecting options for, 365
   35 mm film
      aspect ratios in, 314
      converting to digital, 347
   35 mm lens settings, 265–267
   50 mm lens settings, 265–266
A
A over B composites, 78
absolute vs. relative time, 62
Activity Monitor, 128
Adaptive Sample Limit, 59–61
Add blending mode, 94
Add mode, for masks, 88–89
Add with Invert mode, 88
Adjustment layers
   edges in, 195
      for optimizing projects, 110–111
      for selections, 97
Adobe Media Encoder (AME), 32, 123–124
advanced color options
   1.0 gamma for, 364–365
   16-bpc composites and, 345–346
   for 32-bpc composites, 361–363
   Cineon files and, 347–348
   Cineon Log space and, 350–353
   Color Management for. See
      Color Management
   Compander effect, 363–364
dynamic range and, 348–350
film and, 347–348
introduction to, 344–345
in linear HDR compositing, 357–366
in linear LDR compositing, 367–373
linearized working space and, 353–355
QuickTime for. See QuickTime theory vs. practice of, 373
video gamma space and, 353–355
advanced composition settings, 110
aerender, 124–125
Alexa cameras, 372
Aligned toggle, 221
Allow Keyframes Between Frames, 52
Almasol, Jeff
automatic camera projection
setup script by, 292
KeyEd Up by, 127
light wrap formula by, 389
rd: Pre-compose by, 104
Alpha Add blending mode, 90
Alpha Bias, 185
alpha channel. See also RGBA
(red, blue, green, alpha)
interpretation, 17–18
in Levels, 137–139
in selections, 73–74
view, 182, 219
Alpha Inverted Matte, 98
Alpha Matte, 98
Alvarez, Lloyd
Batch Search-n-Replace
Paths, 127
BG Renderer by, 124
Immigration by, 10
Render, Email, Save, and
Shutdown, 125
Throttle-n-Purge, 128
Zorro by, 38
ambient motion
animation for, 419
elements for, 419
introduction to, 418–419
plumes, 420–421
smoke trails and, 420–421
AME (Adobe Media Encoder), 32, 123–124
amplitude, 338
anaglyph view, 280–282
anchor points
Stabilize tracks and, 247
in Timeline panel, 55–57
Angle of Depth, 267
animation
in-between, 213
of ambient motion, 419
anchor points in, 55–57
in camera, 285–289
copy and paste, 50–51
keyframe, 214
of masks, 90–91
parent hierarchy in, 55, 57–58
presets for composites, 29–30
relationships in, 55–58
straight-ahead, 213
strobe, 328
Timeline for. See Timeline panel
triggering at markers, 328–329
of wind, 419
animator qualifications, 69–70
Annable, Graham, 69
Aperture, 294–296
arithmetic operators, 323
Arrange Project Items into Folders, 106
arrays, 340–341
Arrir Alexa cameras, 198
ARRILogC, 372
Artbeats, 441
articulated mattes
introduction to, 211
for organic shapes, 211–214
for rotobezier shapes, 214–215
ASA settings, 268–269
aspect ratios, 309
assembling shots logically, 33–34
asterisk (*) key, 38
atmospheric haze, 406–408, 413
attached storage, 117–118
audio layers, 321
Audio Settings, 15–16
Auto Bezier, 50–52
Auto Levels, 140
Auto-Save, 14–15
Auto-scale
cropping in, 238
introduction to, 236
Smoothness settings in, 237
Synthesize Edges in, 238–239
AV Features/Keys, 37
Avatar, 278, 399
B
background rendering, 123–126
backgrounds
for clarity in mattes, 169–170
in composites, 27–29
depth cues in, 408
in Extract, 172
fire elements in, 440–441
first pass of color keys for, 177–179
garbage mattes for, 176–177
in Keylight, 175
in Linear Color Key, 173–174
point tracking and, 233–234
refining mattes for, 179–184
Screen Balance for, 185
Screen Gain for, 184
in sky replacement, 412
stabilizing, 420
backlighting, 389–391, 407
baking Maya camera data, 259
banding, 142–143
base frames, defined, 207
Batch Search-n-Replace Paths, 127
Bay, Michael, 283
Beam effect, 339–340, 434
Bellantoni, Patti, 315
bevels, 275
Bezier
handles, 417
masks, 86–87
motion paths, 50
Rotobezier vs., 214–215
BG Renderer, 124–125
Bias settings, 185
billowing smoke
introduction to, 415–417
Liquify effect for, 417–418
Mesh Warp for, 417
Birn, Jeremy, 399
bit-depth identifier, 143
bitmap alpha edges, 78
bits per channel (bpc). See specific numbers of bpc
black
in bitmaps, 78
in Cineon log files, 352–353
in color keying. See color
in depth maps, 299–300
in Difference mode, 95
in edge premultiplication, 81–82
in Extract, 171–172
hex color values for, 367
input. See Input Black/Input White
in Luminescent Premultiply, 97
on monitors, 91, 349
output. See Output Black/Output White
pixel values in, 34
pixel values of, 73, 91
in Screen mode, 93–94
as transparency in mattes, 73
Black & White effect, 387–388
black and white images from color sources, 387–389
painting in, for alpha channel cleanup, 218–219
Blade Runner, 407
blending modes
Add, 94
Adjustment layers and, 97
Color, 96
for colors, 364–365
Difference, 95
for fire, 441–442
for fire composites, 441
HSB, 96
introduction to, 76, 92–93
for LDR, 365
Light, 95
Luminescent Premultiply, 97–98
Multiply, 95
Overlay, 95
Preserve Underlying Transparency, 96–97
Screen, 94
Silhouette, 96
Stencil, 96
Block Size, 68
blue channel. See also RGB (red, green, blue)
in Extract, 172
grain and, 303, 305
linear keyers for, 170
YUV in, 188
bluescreening. See color keying
bluescreens
in color keying, 174–179
cycloramas and, 199
Screen Balance for, 185
sky as, 419
sky vs., 410–411
blur effects
bokeh. See bokeh blur
compound. See Compound Blur
in Effects & Presets panel, 30
Motion Blur for. See Motion Blur
types of, 306
blur maps, 299–302
bokeh blur
3D compositing and, 294–296
blur maps in, 299–302
Camera Lens Blur and, 296–302
edges in, 302
introduction to, 268, 292–294
summary of, 302–303
bouncing ball animation, 44–50, 69
Box Blur, 396
Brightness & Contrast, 133–135
brightness adjustments
in Curves, 146–147
in Levels, 137–138
bump maps, 400
C
Cache Work Area in Background in Global Performance Cache, 104, 118–119
for optimizing projects, 104
caching, 27–29
Calibration LUTs, 373
camera, in After Effects
3D layers in, 274–278
animating, 285–289
bokeh blur in. See bokeh blur
camera projection in, 289–291
chromatic aberration and, 309, 312
color distortion and, 314–316
distortion and, 308–316
emulating physical cameras, 267–274
focal depth in. See focal depth formats and, 313–314
frame rates and, 313
grain in, 303–308
lens artifacts and, 309
lens data and, 268–269
lens distortion and, 271–274
lens flare and, 310–311
lens settings for, 265–267
options and, generally, 264
panoramas and, 313–314
performance anxiety and, 276–278
push functions in, 287–289
ray-based, extruded 3D in, 274–278
real camera settings vs., 267
reports, 268–270
seeing with, 265–267
settings in, 265, 270
stereoscopic 3D and. See stereoscopic 3D integration
training the eye for, 316
understanding, generally, 264
vignettes and, 309, 311
zoom functions in, 287–289
camera integration
3D tracking data in, 259–260
for motion tracking, generally, 259
working with Maya scenes in, 260–261
Camera Lens Blur, 296–302
camera mapping, 289
camera projection, 289–291
Camera Tracker, 412
cameras, physical
chromatic aberration by, 309, 312
color distortion in, 314–316
distortion by, 308–316
dynamic range of, 348–350
formats in, 313–314
frame rates in, 313
Keylight and, 197–198
lens artifacts by, 309
lens flare by, 310–311
panoramas in, 313–314
shooting for stabilization, 242–243
vignettes by, 309, 311
Cameron, James, 283
Index

Canon DSLR, 205
Caps Lock, 24
Cardeiro, Michael, 310
Casablanca, 313
CC
Lens Effect, 321, 425
Light Burst 2.5, 336
Light Rays effect, 394–395
Simple Wire Removal tool, 223
Channel Combiner effect, 84
Channel menus, 171–172
channels for color matching in Curves, 144
histograms and, 140–143
in Hue/Saturation, 150–153
in Levels, 138–140
Chapman, Brennan, 108
Checkbox Control, 338
choking holes, 194
chroma subsampling, 186–187
chromatic aberration, 309, 312
chunky explosions, 445–446
CIN file format, 21
CINEMA 4D plug-ins, 259
Cineon
in Color Management, 353
HDR in, 347–348
Log space in, 350–353
output of, 366
circles of confusion, 297
Citizen Kane, 293
clamped lights, 379–380
climate. See environment
Clip White/Clip Black/Clip Rollback, 186
clipping, 154–155
Clone Stamp tool, 416
cloning, 221–223
closing holes, 194
clouds, 412, 415–417
clutter-free workflows, 36–41
"The Colbert Report," 168
Collapse Transformations, 108–109
Collect Source Files, 13
color
advanced options for. See advanced color options
blending. See color blending
blending modes, for
selections, 96
commentary, in Timeline, 37–38
color correction
distortion in cameras, 314–316
finishing, 166
keying. See color keying
linear key for, 170
look of. See color looks
look-up tables. See LUTs
management of. See color management
matching, in Levels, 138–140
nonlinear response to, 355
pass, in multipass rendering, 401–403
Project Settings for, 15
sampling and conversion, 340–341
settings, in linearized working space, 355–357
spaces, encoding vs. compositing, 353
spill, in Keylight, 195–197
timing, 152
color blending
with 1.0 gamma. See 1.0 gamma (linear) color blending
modes for, 97
for tint effect, 387
color correction
Auto Levels in, 140
banding in, 142–143
brightness adjustments, 137–138, 146–147
contrast adjustments, 154–157, 143–149
foot room in, 142
gamma adjustments, 137–138, 143–149
head room in, 142
Hue/Saturation tool for. See Hue/Saturation
image optimization and, 153
introduction to, 132–133
LCD displays in, 142
Levels for. See Levels
matching foreground/background. See Hue/Saturation
outside After Effects, 166
Photoshop’s Curves control for, 143–149
summary of, 165–166
color keying
bluescreen for, 174–184
core mattes in, 181–182
costume contamination and, 190
edge mattes in, 181
examining results in motion, 183
Extract effect for, 171–172
first passes in, 177–179
garbage mattes in, 176–177
greenscreen for, 174–184
hi-con mattes for, 170–174
image quality and, 189
introduction to, 168
Keylight for. See Keylight
color looks
black and white presets for, 387–388
day for night presets for, 388–389
introduction to, 380
in physical cameras, 309
popular grades for, 387–389
SpeedGrade for. See SpeedGrade
Color Management
Cineon Settings in, 347, 353
Description section of, 366
display in, 371
color management
in linear LDR compositing, 367–370
linear LDR compositing vs., 370–371
LUTS in. See LUTs (look-up tables)
in output modules, 32–33
overview of, 367–369
Color Management, Preserve
RGB options in, 370–371
color management, QuickTime
for. See QuickTime
Color Management, sRGB in, 356
color matching
direction and position in, 163–164
in dramatic lighting, 157–161
in Hue/Saturation, generally, 150–153
individual channels for, 138–140
introduction to, 137, 150–152
with no clear reference, 161–163
in ordinary lighting, 153–157
Colorista, 166, 315
column views, 36–37
combining projects, 13–14
comp space to layer surface, 339–340
Compander effect, 363–364
composites
alpha channel interpretation in, 17–18
animation presets for, 29–30
assembling shots logically, 33–34
backgrounds in, 27–29
caching, 27–29
combining projects, 13–14
Composition Settings for, 22
Composition viewer for, 11, 177–179
consolidating projects, 13–14
clear contexts for, 11–13
effects in, 29–30
fields in, 18–20
frame rates in, 18
importing sources of, 8–11
Interpret Footage for, 16–20
introduction to, 2–3
keyboard shortcuts for, 11–13
matching, 30–31
matching colors in. See
Hue/Saturation
Missing Footage in, 11–13
moving projects, 15–14
multiple. See multiple composites
multiprocessing of, 24–26
nesting, 103
optimizing. See optimizing projects
organizing sources of, 8–11
output of, 30–33
A over B, 78
overriding, 30–31
Photoshop files in, 21–22
pixel aspect ratios in, 18–20
plug-ins for, 29–30
precipitation in, 424–425
previewing, 7, 27–29
Quality Settings for, 15–16
pulldowns in, 18–20
quality of, 22–24
rendering, 7
reflection of light in, 389, 393
review queue for, 30–33
Render Settings for, 30–31
resolution of, 22–24
responsiveness of, 24–26
saving options, advanced, 14–15
selections for. See selections settings for, 15–22
setup for, 6–7
shadows in, 389, 396–399
source formats in, 20–22
source of light in. See light
Time Sampling for, 31
user interfaces for, 22–29
workspace setup for, 3–5
composing formula, 78
compositions. See composites
Compund Blur
for fire composites, 442
for plumes, 420–421
for smoke, fog, mist, 415
compression, 187
concatenation, 110
conditional events, 326–330
Confidence settings, 250–251
consolidating projects, 13–14
contact shadows, 396–399
context-clicks, 11–13
continuous access, 116–118
contrast
for clarity in mattes, 169
in Curves, 143–149
in hi-con mattes, 170–174
in Hue/Saturation, 152
in Levels, 134–137
Convergence, 282–285
copy and paste animations, 50–51
core and decay, 434–437
core mattes, 186, 194
Corner Pin tracking, 248, 253–258
costume contamination, 190
crashing of After Effects, 128
Create Stereo 3D Rig, 274, 279
cropping, 238
CS5.5 project format, 15
CS6MaterialProject.aep, 276
csikszentmihalyi, Mihaly, 132
CUDA-enabled graphics cards, 274, 277
curves control, 143–149
Custom Look layers, 383
cycorama, 198–199

D
DaVinci Resolve, 166
The Day After Tomorrow, 39, 418, 424
day for night presets, 388–389
Deactivate Live Update, 24
Decontamination, 302
deep images, 409
delay, 324
delta, defined, 186
density, 88, 351
depth of field
in cameras, 268
in multipass 3D compositing, 400
Despill Bias, 185
Despot cleanup tools, 187
difference
blending mode, 95
mattes, 175
diffraction, 415
Diffraction Fringe, 299
Diffuse layer, 400–401
Index

dimensionality, 443–445
direction of light, 376–378
Directional Blur, 61
Director of Photography (DP), 190–201
Dirt maps, 400
disk caching
attached storage for, 117–118
Cache Work Area in Background in, 104, 118–119
persistent disk cache as, 116–117
Premiere Pro’s Dynamic Link in, 119–121, 124
Disney Animation, 69
Displacement Map, 439–440
Display Style, 15
distortion by cameras, 308–316
DP (Director of Photography), 190–201
DPX file format
color in, 347
dynamic range of, 350
introduction to, 20–21
drop shadows, 396
DSLR cameras
dynamic range of, 350
Keylight and, 197–198
dust busting, 223
Dynamic Link, 119–121, 124
dynamic range, high. See HDR (high dynamic range)
dynamic range, low. See LDR (low dynamic range)

e
Ease Curves, 45–46
Ease, 45–46
Easy Rider, 309, 391
Ebberts, Dan, 107
edge mattes, 181, 186
edges
bitmap alpha, 78
Channel Combiner effect and, 84
decontamination of, 209–210
feathered alpha, 78–79
fringing of, 82–83
Guess option for, 82
importing correctly, 82–83
Interpret Footage for, 82–83
introduction to, 78
in Keylight, 175
opacity of, 80
premultipliation of, 81–84
protecting in Extract, 172
protecting in mattes, 170
Remove Color Matting effect and, 83–84
selection, 194–195
of selections, 78–84
transparency of, 81–84
troubleshooting, 83–84
effect tracks parented layer, 335–336
effects
Beam, 339–430, 434
Black & White, 387–388
blur, 396
CC Lens, 321, 425
CC Light Rays, 394–395
Channel Combiner, 84
Componder, 363–364
in composites, 29–30
energy, 433–437
Exposure, 328, 442
Extract, 171–172
Grow Bounds, 109–110
Lens Flare, 339–340
linking parameters to properties with, 321–323
Liquify, 417–418
Ramp, 299–300, 304, 408
Red Giant Corner Pin, 258
Remove Color Matting, 83–84
resetting, 135–136
for selections, 77
Separate RGB, 312
Shatter, 446
tracks parented layer, 335–336
in VFX, 325, 331
Effects & Presets panel, 5–6, 30
Einstein, Albert, 36, 377
elements
for ambient motion, 419
for fire, 440–441
for wind, 419
embedded timecodes, 16
Emitter, 425
Enable Cycle Mask Colors, 212
energy effects, 433–437
environment
ambient motion in, 418–421
bellowing smoke in, 415–418
depth cues for, 407–408
depth maps for, 408–409
fog in, 412–415
infinite depth in, 412–415
introduction to, 406
Liquify effect for, 417–418
masking and adjusting, 413–414
Mesh Warp for, 417
mist in, 412–415
particulate matter in, 406–409
plumes in, 420–421
precipitation in, 421–425
sky replacement in, 410–412
smoke in, 412–418
smoke trails in, 420–421
wet look in, 421–423
wind in, 418–421
Environment layer, 276
Eoin, Marcus, 318
EPIC cameras, 363
Erodilation, 194
Error Threshold, 68
Excel spreadsheets, 50
explosions, 445–446
Exposure control, 362
Exposure effect, 328, 442
exposure in cameras, 268
expressions
color sampling and conversion in, 340–341
from comp space to layer surface with, 339–340
conditional events in, 326–330
costs, 338
copying, 320, 325
creating, 319–320
defined, 318–319
deleting, 320
editing, 320
effect tracks parented layer, 335–336
exposing, 320
fading while moving away from camera, 339
interpolation methods in, 337–339
Index

index, 454–407
HDR (high dynamic range), 16–165
gamma exposure slamming, 345–346
gamma values in HDR, 353–355
garbage mattes (gmattes), 347–348
cineon files, 349–348
cineon Log space, 350–353
digital film, 351–353
dynamic range, defined, 348–350
film, 347–348
introduction to, 345
linear compositing in. See linear HDR compositing
linearized working space, 355–357
source, 360–361
video gamma space, 353–355
head room, 142
heat distortion
introduction to, 437–438
process of, 438
pyrotechnics, 437–440
re-creating, 438–440
Hedberg, Mitch, 226
hero frames, 283–285
hex color values, 367
hi-con (high contrast) mattes, 170–171
high dynamic range (HDR). See HDR (high dynamic range)
histograms
in Extract, 171–172
in Levels, 140–143
hits, 432–433
Hold keyframes, 49
holdout masks, 258
holdout mattes, 191
horizontal X dimension, 46–59
hot look, 434–437
hotspots, 377–378
HSB (Hue, Saturation, Brightness). See also Hue/
Saturation, 96, 150
HSLA (hue, saturation, lightness, alpha), 341
http://forums.adobe.com/community/aftereffects_general_discussion, 342
http://forums.creativecow.net/forum/adobe_after_effects_expressions, 342
Hue/Saturation
gamma exposure slamming, 164–165
Linear keyframe type in, 50–52
markers in, 329
organic motion in, 289
separating XYZ in, 46–48
Show Properties in, 43
Show Reference Graph in, 44
summary of, 50
transform boxes in, 48–49
view in, 44–45
graphics cards, 114
gray
in gamma settings, 355
in linearized workspaces, 357
matching, 152
greyscale
in depth maps, 409
in mattes, generally, 73
in multipass rendering, 401–403
green
matching, 155, 158
on sets, 190
spill suppression for, 188–189
suppressing spilling of, 196
green channel. See also RGB (red, green, blue)
in Extract, 172
in gamma settings, 355
in linearized workspaces, 357
matching, 152
Greek alphabet
Granny
attachment, 347–348
Grass, 294
graph editor
Allow Keyframes Between Frames in, 52
Auto Bezier keyframe type in, 50–52
basic animation in, 44–45
Ease Curves in, 45–46
Easy Ease in, 45–46
Hold keyframe type in, 50–52
Hold keyframes in, 49
Layer view vs., 51
H
H.264 files, 123, 369
Haas, Ernest, 264
hacking shortcuts, 126–127
halation, 268
halos, 394
hand tool, 23
handheld shots, 234, 243
hard (direct) light, 377
haze, 406–407
HDR (high dynamic range)
16-bpc composites, 345–346
Cineon files, 347–348
Cineon Log space, 350–353
digital film, 351–353
dynamic range, defined, 348–350
film, 347–348
introduction to, 345
linear compositing in. See linear HDR compositing
linearized working space, 355–357
source, 360–361
video gamma space, 353–355
introduction to, 149–150
matching colors, direction and position, 163–164
matching colors, dramatic lighting, 157–161
matching colors, generally, 150–153
matching colors, no clear reference, 161–163
matching colors, ordinary lighting, 153–157
reducing saturation in, 388
suppressing color spills with, 195
Hue, Saturation, Brightness (HSB), 96, 150
hue, saturation, lightness, alpha (HSLA), 341

I
Identifier, 364
idx variable, 350
IEC (International Electrotechnical Commission), 356
If It's Purple, Someone's Gonna Die, 315
if statements, 326–329
The Illusion of Life, 69–70
image quality, 189
image sequences, 18
Imagineer, 253, 259
Immigration, 10
Import & Replace Usage, 121–122
importing
composite sources, 8–11
MochaImport for, 256
renders, 121–122
selections, 82–83
in-between animation, 213
Incidence passes, 400
The Incredibles, 303
Independence Day, 410
index attribute, 323, 327
indirect light, 396–399
Industrial Light + Magic, 364
infinite depth, 412–415
Info panel
color value settings on, 346
tearing off, 4–5
Input Black/Input White
for fire composites, 443
in fire elements, 443
in Levels, 133–137
in RGB histograms, 141
interactive light, 431–432
interaxial distance, 283
interlaced footage, 19
Intermediate Result, 180–182
interpolation methods, 357–339
Interpret Footage
in composites, 16–20
for edges, 82–83
inverse-square law, 379–380
IRIDAS .cube LUT, 385
J
Jacob's Ladder, 331–332
JavaScript, 321–324
Johnston, Ollie, 69
JPEG file format, 20–21
K
Key Color eyedropper tool, 173–174
Key Tweak, 218
keyboard shortcuts
for Add to Render Queue, 8
for adding images, 6
for Adjust Tension pointer, 215
for alpha channels, 139
for Alpha Overlay/Alpha View, 208
for animated masks, 90
for backgrounds, 169
for Bezier masks, 86
for Cache Work Area in Background, 118
for centering zooms, 186
for closing multiple compositions, 106
for color channels, 139
for composites, 11–13
for Composition viewers, 106
for Corner Pin tracking, 258
for creating adjustment layers, 111
for creating expressions, 319
for Deactivate Live Update, 24
for duplicating layers, 99
for Easy Ease, 45–46
for Effects & Presets panel, 5–6
for Find Missing Footage, 12
for flipping through color channels, 205
for framing layers, 56
for full resolution, 205
for grading shots, 383
for Graph Editor, 43
for hiding layer controls, 28
for Hold keyframes, 49
for Import Multiple Files, 4
for Interpret Footage, 17
for keyframe navigation/selection, 54
for keyframe offsets, 55
for layer and composition markers, 38
for layers in Timeline, 52–53
for locking layers, 38
to look at RGB color channels, 171
for mask shapes, 84–85
for maximize and center windows, 9
for Motion Blur, 59
for opacity, 80
for open Project Settings, 15
for parent layers, 57–58
for precomping, 103
to R, G, B, and A, 29
for relinking missing footage, 11
for Reload Footage, 12
for Render Queue, 30
for reveal Tools Panel, 4
for revealing comps in Layer view, 107
to show/hide animation paths, 47
for showing grid/rulers, 28
for Start Frame number in Composition Settings, 16
for tear away & toggle Render Queue, 7
to tear away panel, 4–5, 7
for Time Remap, 64, 324
for Time Stretch, 63
for Timeline navigation, 39–41
for Timeline views, 41
for transform boxes, 48–49
for Transform properties, 42
for trimming clips, 206
for View Options, 29
for viewing Alpha Channel, 219
Index

A
Add mode for, 88–89
Add with Invert mode for, 88
animated, 90–91
Auto-trace for, 76, 91
combinations of, 88–90
copying, 76, 91
defined, 3
density of, 88–89
First Vertex for, 91
for fog, 413–414
for mist, 413–414
in SpeedGrade, 385
Luminescent Premultiply, 97–98
LUTs (look-up tables)
  Calibration, 373
  in linear LDR compositing, 373
  SpeedGrade and, 368, 371, 373
Viewing, 373

B
Basic Focus options, 274
  linking effect parameters to,
  properties, 321–323
  "liquid" 2D layers, 415
looking, 417–418
Live Update, 24
Local Motion Estimation (LME), 67
locating the light, 377
Locking
  foregrounds off, 244
  layers, 37–38
  shots, 239–240
  source time, 221
log encoding, 351–353
logarithmic curves, 351–352
<Item Number>
look-up tables (LUTs). See LUTs (look-up tables)
Looks, by Red Giant Software, 166
loopIn(), 325–326
looping keyframes, 325–326
loopOut(), 325–326
low dynamic range (LDR). See LDR (low dynamic range)
M
m files (Maya), 259–261, 283
Mac OS X
  crashing of After Effects on, 128
gamma value default in, 354
memory management on, 128
Shortcuts and Preferences on, 126–127
Magic Bullet Colorista, 166
Magic Bullet Looks, 311
Mairinger, Franz, 168
Marcie, 347
marker attributes, 327–329
Maschwitz, Stu
  on action movies, 429
  on daring, 380
The DV Rebel’s Guide by, 308
on gut emotional reactions, 166
Mask Feather Tool, 215–217
masks
  Add mode for, 88–89
  Add with Invert mode for, 88
  animated, 90–91
  Auto-trace for, 76
  combinations of, 88–90
  copying, 76, 91
  defined, 3
  density of, 88–89
  First Vertex for, 91
  for fog, 413–414
  for mist, 413–414
  in SpeedGrade, 385
  Subtract mode for, 88–89
matching colors. See also color correction
  basic technique for, 152–153
direction and position in, 163–164
  in dramatic lighting, 157–161
  individual channels for, 138–140
  introduction to, 137, 150–152
  with no clear reference, 161–163
  in ordinary lighting, 153–157
  matching composition settings, 30–31
### Index

Matching Tolerance eyedropper tool, 173  
Material Options, 276  
Math.min(), 330  
matte  
Alpha/Alpha Inverted, 98  
articulated, 211–215  
clarity in, 169–170  
core, 181–182, 186  
Difference, 175  
edge, 181, 186  
feathered, 215–217  
garbage, 176–177, 410–411  
hi-con, 170–174  
holdout, 184, 191  
Luma/Luma Inverted, 98, 172  
procedural, 168–170  
procedural garbage, 191–194  
protecting edges in, 170  
refining, 179–181, 208–210  
for selections, 73  
track, 98–100  
tracked, 217–218  
translating, 217–218  
maxDist, 337, 339  
maximize/center windows, 9  
Maya (.ma files)  
6.5 cm distance in, 283  
working with scenes in, 259–261  
Meka, Satya, 312  
memory acceleration, 115  
memory management, 128  
Mesh Warp, 417  
Method settings, 240–241  
methods, 322–323  
Meyer, Trish, 3  
Millions of Colors+-, 6  
minDist, 337, 339  
Mini-Flowchart, 105–106  
Minimax, 192–193  
Missing Footage, 11–13  
mist  
introduction to, 412–413  
making and adjusting, 413–414  
moving through, 415  
mixed bit depths, 363–364  
mocha  
3D camera tracker in, 259  
by Imagineer, 253  
shape in, 76  
mocha-AE  
basics of using, 254–256  
Copy/Paste, 76  
Corner Pin tracking with, 253  
introduction to, 252–253  
issues in, 256–258  
MochaImport script, 256  
Möhl, Mathias  
KeyTweak by, 90, 218  
MochaImport by, 256  
monitor-referred values, 355  
motion  
Motion Blur  
decoding, 59–61  
enhancement vs. elimination in, 61–62  
motion blur, as flaw in stabilized shots, 242  
Motion Blur  
introduction to, 58–59  
roto- and 216–217  
motion blur, in Tracker panel, 251–252  
Motion Tracker Options  
applying, 246  
subpixel positioning in, 250  
motion tracking  
3D Camera Tracker for, 227–232  
camera integration for, 259–261  
introduction to, 226–227  
mocha AE planar tracker for, 252–258  
point tracker for. See point tracker  
Tracker panel for, 245–253  
Warp Stabilizer for. See Warp Stabilizer  
MPEG-2, 123  
multipass 3D compositing, 399–404  
multiple composites  
Advanced Composition Settings for, 110  
Collapse Transformations for, 108–109  
introduction to, 102  
nested time for, 110  
nesting, 103  
precomps, issues with, 107–109  
precomps, using, 102–104  
Project panel for, 104–105  
space management for, 108  
time management for, 108  
Timeline management for, 105–107  
Multiply blending mode, 95  
Multiply formula, 95  
Multiply mode, 413  
multiprocessing, 24–26  
multithreading, 25  
muzzle flash, 430–431  
N  
naming conventions, 33  
navigation  
in keyframes, 54  
in Timeline, 39–41  
navearKey(), 327  
Neat Video, 307  
negatives, 350–353  
nested compositions, 64, 103  
nested time, 110  
network rendering, 121, 125  
Newton, Sir Isaac, 379  
Nichols, Roger, 406  
Nietzsche, Friedrich, 53  
night, 388–389  
No Motion, 239–240  
nodal pans, 412  
nodal-based compositing programs, 99  
nose  
grain and, 303–304  
suppressing, in Keylight, 186–188  
type setting for, 412  
None mode, 88–89  
Normal passes, 400  
normality, 399  
normalized pixel values, 91, 95  
Nuke and Shake, 108  
nulls  
in Maya scenes, 260–261  
in Tracker panel, 248–250  
NVIDIA CUDA-certified cards, 277–278
Index

plumes, 420–421
PNG file format, 20–21
Point Control, 338
point of interest, 286
point stabilization, 233, 243–245
point tracker
  Confidence settings in, 250–251
  Corner Pin tracks in, 248
introduction to, 245–246
motion blur settings in, 251–252
mills in, 248–250
Position in, 248
Raw tracks in, 248
rotation in, 248, 250
scale in, 248, 250
selecting features in, 245–247
Stabilize tracks in, 247
Track Type menu in, 247
Transform tracks in, 247
tricky features in, 250–252
tweaking tracks in, 247
points, in articulated masks, 212
Position values, 247–248
pre-render options, 121
Poynton, Charles, 354
pre-rendering, 121–123
precomping, 102–104, 107–109
preCompToLayerDur.jsx, 107
Preferences, 126–127
Premiere Pro's Dynamic Link, 119–121, 124
premultiplication, 81–84
Preserve Frame Rate, 110
 Preserve Resolution When Nested, 110
Preserve Underlying Transparency, 96–97
presets, in SpeedGrade, 385, 387–389

Preview panel
  composites, 27–29, 121
  From Current Time in, 27
  Full Screen box in, 9, 27
  introduction to, 7
  Loop options in, 27
Preferences > Video Preview in, 27
  RAM Preview in, 23
  Skip setting in, 23
primary animation, 419
Primary layers, 383–385
Primatte Keyer, 201–202
Problem Exists Between Keyboard and Chair (PEBKAC), 102
procedural garbage mattes, 191–194
procedural mattes, 168–170
Project panel
  accessing items in, 11
  bit-depth identifier in, 143
  Composition icon in, 6
  as file system, 104
  Find Missing Footage in, 11
  f_table in, 6
  New Folder in, 4
  for optimizing projects, 104–105
  RBcan_f_table.tif in, 6
relinking items in, 11
Project Settings, 15–16
Projection, 292
proxies, 121–123
PSD file format, 21
pt_AEtoC4D script, 259
pt_EffectSearch, 29
pulldowns, 18–20
Puppet tool, 418
Purge, 208–210
push functions, 268, 287–289
pyrotechnics
  blending modes for, 441–442
  chunky explosions, 445–446
  core and decay, 434–437
dimensionality in, 443–445
  energy effects for, 433–437
  explosions, 445–446
  fire, 440–445
  firearms. See firearms
  heat distortion, 437–440
  hot look, 434–437
  introduction to, 428
  light explosions, 445–446
  light interactions for, 442–443
  light sabers, 434–437
linear blending for, 441–442
summary of, 446
Q
quality of composites, 22–24
quality of light, 376–377
QuickTime
  color management in, 9
  flaws of, 18
  introduction to, 34
  linear LDR compositing, 369–370
R
Radial Blur, 61
radiometrically linear color data, 360
Radius, 379
raison, Ken, 428
RAM Preview
  introduction to, 7–9
  in Preview panel, 23
Roto Brush and, 206
Shift+RAM Preview, 27
RAM requirements, 114–116, 128
Ramp effect
  Camera Lens Blur and, 299–300
depth cues and, 408
grain and, 304
Ramp gradient, 138, 140
random(), 332–334
randomness, expressions for, 330–334
raster images, 79
Raw tracks, 248
Ray-traced 3D, 24
red channel
  in Extract, 172
gain and, 303, 305
linear keyers for, 170
YUV in, 188
Red Giant Software
  Colorista by, 166
  Corner Pin effect by, 258
  Looks by, 166
  Primatte Keyer by, 201
  Warp by, 397

460
red, green, blue (RGB). See RGB (red, green, blue)
RED .r3d files, 198
red, blue, green, alpha (RGBA). See RGBA (red, blue, green, alpha)
Redefinery’s Merge Projects, 14
redscreen, 174–184
Reel Smart Motion Blur, 243
refining composites, 7–8
refining mattes
  in Keylight, 186–189, 192
  in Roto Brush, 208, 215
reflected light, 393, 398–399
Region of Interest (ROI) tool, 23–24
Reload Footage, 11
RE:Map plug-in, 400
Remove Color Matting effect, 83–84
Render, Email, Save, and Shutdown, 125
render pipelines, 107–109, 113
render queue
  add to, 8
  keyboard shortcuts for, 30
  panel, 121
  settings for, 30–35
  tear away and toggle, 7
renders
  background, 123–126
  importing results, 121–122
  multipass, 400–403
  network, 121, 125
  saving time, 274
  settings for, 30
  show progress, 121
  speed of, 113
  stereo, 285
Repeat values, 88
Replace Footage, 11
resetting effects, 135–136
resolution
  of composites, 22–24
  full, 205
  preserving, 110
  of shadow maps, 291
responsiveness, 24–26
retiming, 62–69
Return of the Jedi, 164
RE:Vision Effects, 400
RGB (red, green, blue)
  in 8-bpc, 349, 367
  in crazy lighting, 162
  in Curves, 144
  in dramatic lighting, 159–160
  in Keylight color values, 185
  in Levels, 137–139
  in ordinary lighting, 155–157
  Separate RGB effect, 312
  sRGB suppression and, 188–189
  of video images on computers, 187–188
RGAl (red, blue, green, alpha)
  in 16-bpc color mode, 345
  converting to HSLA, 341
  right-clicking, 11
  Rodrigue, Robert, 283
  ROI (Region of Interest) tool, 23–24
  Rollason, Ben, 292
  Rolling Shutter Removal, 309
  Rolling Shutter Repair, 256
  Rosco colors, 185
  rotation, 248, 250
Roto Brush
  3D Camera Tracker and,
    230–231
  depth maps in, 409
  introduction to, 204–205
  Linear Color Key vs., 170
  masks, 75
  Refine Matte in, 208–210
  strength/limitations of,
    208–210
  using, 205–208
rotscooping
  articulated mattes in, 211–215
  feathered mattes, 215–217
  introduction to, 74
  Mask Feather Tool in, 215–217
  Motion Blur and, 216–217
  organic shapes, 211–214
  overview of, 204–205
  Paint for. See Paint procedural matte generation vs., 202
  procedural mattes vs., 168
  Roto Brush for. See Roto Brush rotobeizer shapes, 214–215
  tracking masks in, 215, 217–218
  translating mattes, 217–218
Roving keyframes, 50
RPF files, 399, 409
RPF sequences, 259
Ryan v. Dorkman, 434–436
S
S-curve adjustments, 147–149
sampleImage(), 339, 341
Samples Per Frame, 59–61
Sandison, Michael, 318
SanityCheck, 361, 369
saturation. See Hue/Saturation
saving options, advanced, 14–15
scale, 248, 250
SCARLET cameras, 363
scattering of light, 394–395
scene-referred values
  in floating-point files, 364
  in linear HDR compositing, 360
  in linear LDR compositing, 355
Screen Balance setting, 185
Screen blending mode, 94
Screen Grow/Shrink, 188
screen matte generation. See Keylight
Second Amendment, 429
secondary animation, 419
Secondary layers, 383, 386
seedRandom(), 332–334
segmentation boundaries, 206
selections
  Add blending mode for, 94
  alpha channels in, 73–74
  assessing tools for, 100
  Bezier masks for, 86–87
  bitmap alpha edges in, 78
  blending modes for, 76, 92–98
  Color blending modes for, 96
  combined techniques for, 77
  combining layers of, 72–77
  compositing formula and, 78
  Difference blending mode for, 95
  edges of, 78–84
  effects for, 77
  feathered alpha edges in, 78
  HSB blending modes for, 96
  importing correctly, 82–83
Index

Time Remap
index attribute and, 324
for playing frames with
markers, 329–330
in Timeline panel, 64–65
wiggle expressions in, 332
Time Sampling, 31
Time Stretch
Frame Blend in, 63–64
introduction to, 63
nested compositions in, 64
in Timeline panel, 37
timecodes, 16
Timeline panel
absolute vs. relative time in, 62
anchor points in, 55–57
AV Features/Keys in, 37
basic animation in, 44–45
clutter-free workflows in,
36–41
color commentary in, 37–38
column views in, 36–37
composites in, 6–7
copy and paste animations in,
50–51
dissecting projects in, 53–54
Ease Curves in, 45–46
Easy Ease in, 45–46
Frame Blend in, 63–64
Graph Editor in, 42–50
Hold keyframes in, 49
introduction to, 36
keyboard shortcuts in, 39–41
keyframe navigation/selection
in, 54
keyframe offsets in, 55
keyframes in, generally, 42–50
layer control in, 39–41
Layer menu in, 11
Layer/Source in, 37
layer switches in, 37
Layer view in, 51–52
lower-left icons in, 37
managing multiple comps in,
105–107
Motion Blur in, 58–62
navigation in, 39–41
nested compositions in, 64
parent hierarchy in, 55, 57–58
Parent option in, 37
qualifications of animators
and, 69–70
realistic motion in, summary
of, 50
retiming in, 62–69
Roving keyframes, 51
separating XYZ in, 46–48
Show Cache Indicators on,
116
Show Properties in, 43
Shy layers in, 38
time navigation in, 39
Time Remap in, 64–65
Time Stretch in, 37, 63–64
Timewarp in, 65–69
timing keyframes in, 42–50
transfer controls, 37
transform boxes in, 48–49
Transform controls in, 42
views in, 41, 44–45
timetoFrames(), 330
Timewarp, 62, 65–69
Title/Action Safe, 28
Toggle Grading Panel, 381
toggles
Aligned, 221
defined, 5
for render queue, 7
Toggle Grading Panel, 381
in viewer panels, 28
Toland, Gregg, 293
Toy Story 3, 399
tracked mattes, rotoscoping, 215,
217–218
Tracker panel
Confidence settings in,
250–251
Corner Pin tracks in, 248
introduction to, 245
motion blur settings in,
251–252
nulls in, 248–250
point tracker in, 246
Position in, 248
Raw tracks in, 248
rotation in, 248, 250
scale in, 248, 250
selecting features in, 245–247
Stabilize tracks in, 247
Track Type menu in, 247
Transform tracks in, 247
tricky features in, 250–252
tweaking tracks in, 247
tracking motion between 2D
and 3D, 334–340
tracking scenes, 226–232
training the eye, 316
Trajectory, 309
transfer controls, 37
transform boxes, in Graph Editor,
48–49
Transform controls, in Timeline
panel, 42
Transform tracks, in Tracker
panel, 247
translating mattes, in rotoscoping,
217–218
transparency of selections, 81–84
Trapcode Lux, 395
Trapcode Particular, 421, 423
triggering animation at markers,
328–329
Trousseau, Armand, 2
True Comp Duplicator, 108
Truelight .cube format, 372
Tuersley, Paul
OpenSesame by, 15
pt_AEtoC4D script by, 259
pt_EffectSearch by, 29
Turbulent Noise, 412–415
"The Twilight Zone," 313
Twitter, 325
Twixtor, 69
two-node cameras, 286–287
U
überkey, 53–54
UI (user interfaces). See user
interfaces (UI)
Ultimatte Blue/Green/Super
Blue, 185
uncompressed video recording,
200
Unified Camera tool, 287
Use Alternate Color Estimation,
209
user interfaces (UI)
for composites, 22–29
expression controls for, 338
in SpeedGrade, 381–382
UV (chroma), 187
UV Maps, 400

463
Index

V
Vanilla Sky, 410
Vector Detail, 67
versions of After Effects, 125
vertical Y dimension, 46–59
VFX (visual effects)
  loopOut() in, 325
  random values in, 331
  shots for, 269
video
  frame rates in, 313
  gamma space of, 353–355
  linear HDR compositing for, 357–360
Video Copilot, 310
videocopilot.net, 392
views
  Alpha channel, 182
  anaglyph, 280–282
  Composition, 106, 177–179
  Flowchart, 53–54
  Layer, 51–52
  of LUTs, 373
  in Preview panel, 28
  in Timeline panel, 41
  vignettes, 309, 311
  volumetric light, 394–395

W
Walker Effects, 399
warm vs. cool color looks, 383
Warp Stabilizer
  advanced options in, 242
  auto-scale in, 236–239
  cropping in, 238
  eliminating warping in, 241
  introduction to, 233–234
  locking shots in, 239–240
  No Motion in, 239–240
  point stabilization in, 233, 243–245
  Rolling Shutter Ripple in, 242
  shooting for, 242–243
  smoothness adjustments in, 237
  stabilizing shots with, 234–236
  Subspace Warp in, 241
  Synthesize Edges in, 238–239
  troubleshooting bad results in, 241–242
Watch Folder, 125–126
weighting, 69
wet look, 421–423
What Dreams May Come, 227
white
  in bitmaps, 78
  black and. See black and white
  in Cineon log files, 352–353
  in depth maps, 299–300
  in Extract, 171–172
  hex color values for, 367
  input. See Input Black/Input White
  on monitors, 91, 349
  as opacity in mattes, 73
  output. See Output Black/Output White
  in SpeedGrade, 387–388
  widescreen formats, 314
  wiggle() expressions, 331–332, 338
Wikipedia, 359
Williams, Paul, 406
wind
  animation for, 419
  elements for, 419
  introduction to, 418–419
  plumes, 420–421
  smoke trails and, 420–421
Windows
  memory management on, 128
  Normality by, 399
  Shortcuts and Preferences on, 126–127
  wire removal, 222–223
  wireframes, 277
  Working Space setting, 370
Workspaces
  customizing, 8
  minimal, 4
  setting up, 3–5
  standard, 4
  wrapping, light, 389–391
Wright, Steven, 204
www.adobe.com/support/
aftereffects, 342
www.aenhancers.com, 342
www.motionscript.com, 342

X
X key, 220
X Position keyframes, 47–48
XML, 127–128

Y
Y (luminance), 187
Y Positions keyframes, 47–48
YCrCb, video images in, 187
YUV, 187–188

Z
Z dimension, 46–59
ZBornToy, 399
Zeno’s paradox, 80
zoom functions
  in AE camera, 287–289
  flares and, 392
  in physical cameras, 267–268
Zorro, 38